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Solid state equipment has operational characteristics differing from those of
electromechanical equipment. “Safety Guidelines for the Application,
Installation and Maintenance of Solid State Controls” (Publication SGI-1.1)
describes some important differences between solid state equipment and
hard–wired electromechanical devices. Because of this difference, and also
because of the wide variety of uses for solid state equipment, all persons
responsible for applying this equipment must satisfy themselves that each
intended application of this equipment is acceptable.

In no event will the Allen-Bradley Company be responsible or liable for
indirect or consequential damages resulting from the use or application of
this equipment.

The examples and diagrams in this manual are included solely for illustrative
purposes. Because of the many variables and requirements associated with
any particular installation, the Allen-Bradley Company cannot assume
responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Allen-Bradley Company with respect to use
of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without
written permission of the Allen-Bradley Company is prohibited.

Throughout this manual we use notes to make you aware of safety
considerations.

!
ATTENTION:  Identifies information about practices or
circumstances that can lead to personal injury or death, property
damage, or economic loss.

Attentions help you:

• identify a hazard
• avoid the hazard
• recognize the consequences

Important: Identifies information that is especially important for successful
application and understanding of the product.

AdaptaScan is a trademark of Allen-Bradley Company, Inc.
Microsoft and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft Corporation.

Important User Information
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This manual is a reference guide for using the AdaptaScan Software.
It describes features and procedures for configuring the operation of
the AdaptaScan Bar Code Reader.

Because this is a reference manual it covers all the features of the
AdaptaScan Software.  You may not use or need to use all the
features, so use the manual as needed.

If you’re just getting started, make sure you work through the
Getting Started chapter.  It takes you through all the steps
required to get the Reader scanning and decoding bar code
symbols.

The AdaptaScan Bar Code Reader includes a scanner and decoder in
a single compact package.  The Reader is configured using a
Microsoft  Windows 95  or Windows NT  based package that lets
you create, store and download applications.  To simplify application
design, the AdaptaScan software uses menus, dialog boxes and tools
which are standard in Windows.

Applications are transferred between your computer and an
AdaptaScan Reader using a communication cable.

This manual is written for the individual responsible for designing
bar code applications.  We assume you are familiar with bar code
terminology.  A glossary is provided at the end of this manual if you
are not familiar with a word or acronym.

Because AdaptaScan software runs in Microsoft Windows, you
should know how to use a mouse, choose commands, and work with
Windows and dialog boxes.  To learn basic windows techniques, read
the User’s Guide that came with your Microsoft Windows package.

The AdaptaScan Software package comes with:

• Two (3 1/2 inch) installation disks

• Software registration forms

• AdaptaScan Software manual

What is AdaptaScan?

Intended Audience

Software Package



Using this ManualP–2

This manual is organized as follows:

Chapter Title Description

Preface Describes the purpose and contents of the
manual, the intended audience and conven-
tions used.

1 Installation Explains how to install AdaptaScan Software
on a personal computer.  Also describes how
to download new firmware to a Reader.

2 Working with Projects Covers some basics on using AdaptaScan
software.

3 On-Line Communications Describes how to go on-line, use compare,
obtain scanner metrics and perform other on-
line functions.

4 Getting Started Provides step-by-step instructions that config-
ure the Reader to scan and decode a bar code
symbol.

5 Scanner Setup Describes how to configure the operation of
the Reader’s scan beam.

6 Defining Labels Describes how to create and use label setups.

7 Decoder Setup Describes how to configure the operation of
the Reader’s decoding functions.

8 Communication
Port Settings

Provides instructions on how to configure the
Reader’s communication ports.

9 Configuring Discrete 
Inputs and Outputs

Describes how to configure the operation of
the Reader’s discrete input and output mod-
ules.

10 Defining Messages Explains how to define the content of the data
messages sent by the Reader.

11 Using Match Tables Describes how to configure and use match
tables.

12 Downloading 
Configurations

Provides instructions on how to setup and
download applications to a single or  multiple
Reader(s).

13 Printing a Project Describes how to printout a project.

14 Dynamic Data Exchange Describes how to exchange data with other
Windows applications supporting DDE such as
Microsoft Excel�.

Appendix A ASCII Character Set ASCII conversion chart.

Appendix B Preset Read Ranges 
A, B, C, and C+

Read range charts and tables for the four pre-
set read ranges.

Appendix C Metacharacters Describes metacharacters and how they are
used.

Appendix D Transmission Check Describes LRC and checksum transmission
checks.

Contents of Manual
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The following conventions are used throughout this manual:

• Reader refers to the AdaptaScan Bar Code Reader

• Windows refers to Microsoft Windows 95 or Windows NT

• A hand followed by italicized text in the left margin gives helpful
hints:

☞  Use the Monitor dialog to verify read percentages while
adjusting the scan beam.

The following table lists publications related to the AdaptaScan
Software and the AdaptaScan Bar Code Reader.

Publication Number Description

2755-837 AdaptaScan Bar Code Reader User Manual

2755-6.8 Application Guide for AdaptaScan Bar Code Readers

1485-6.7.1 DeviceNet Cable System Planning and Installation Manual

1770-6.2.2 Data Highway / Data Highway Plus / Data Highway-485 Cable
Installation Manual

1787-6.5.3 DeviceNet Manager Software (Catalog No. 1787-MGR) User Manual

1749-6.5.5 DeviceNet Adapter Module (Catalog No. 1749-ADN) User Manual

1747-6.5.2 DeviceNet Scanner (Catalog No. 1747-SDN) Configuration Manual

1771-6.5.118 DeviceNet Scanner (Catalog No. 1771-SDN) Configuration Manual

If you should require assistance or need additional information on
operating the AdaptaScan Reader, Configuration Software, or
accessories, you can:

• access technical support and other information at the
Allen-Bradley web site http://www.ab.com/

• use the Technical Support Fax Back system (available 24 hrs a
day) at 1-440-646-6701

• send a fax describing the problem / question to 1-440-646-6890
for technical support

• call 1-440-646-6800 between 8AM and 5PM (EST), Monday
through Friday to talk to a technical support representative

• write to Allen-Bradley Technical Support
1 Allen Bradley Drive
Mayfield Heights
Ohio 44124-6118

Conventions

Related Publications

Technical Support
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This chapter contains these sections:

Section Page

System Requirements 1–1

Installing AdaptaScan Software 1–2

Downloading Firmware 1–5

The minimum hardware and software requirements for installing and
running AdaptaScan software are:

Hardware

• Personal computer (486/25 MHz minimum)
8 MB of memory (RAM), VGA or higher resolution, with mouse

• 3.5 inch high-density (1.44 MB) disk drive

• Hard disk with 2 MB of free space

• Configuration cable (Catalog No. 2755-NC48 for Series B
Reader, 2755-NC43 for Series A Reader) to connect the personal
computer to the Reader.

Software

• AdaptaScan Software (Catalog No. 2755-ASN)

• Microsoft Windows 95 or Windows NT

Optional Equipment

• A printer for project printouts.

Chapter Objectives

System Requirements
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This section shows how to install the AdaptaScan Configuration
software.

To install the AdaptaScan Configuration software:

1. Insert the AdaptaScan disk #1 in the appropriate floppy disk
drive.

2. In the Program Manager window, choose Run from the File
menu.

The Run dialog opens.

3. In the command line box, type the drive letter of the drive
containing the AdaptaScan diskette followed by a colon and the 
word setup.

For example, type a:setup

Then click OK  or press ENTER.

The installation begins.  You are prompted to continue or exit the
installation.

Installing AdaptaScan
Software
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4. Click Continue to proceed with the installation.

You are prompted to verify/provide registration information.

5. Enter the registration data.  Verify the software serial and catalog
number with the label on the software diskette.  Click Continue
to proceed with the installation.

You are prompted for the location of files to be installed.

We recommend that you use the default installation path.  To
change the installation drive or file name, click the Set Location
button.

6. Click the Install  button to proceed with the installation

You are shown the progress of the installation.  Insert disk #2
when requested.

A message indicates when the installation is complete.
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AdaptaScan Installation Summary

The default AdaptaScan installation:

• Copies files to disk under the target drive and directory
(C:\AS_OLP) or the location specified during installation.

• Adds ”AdaptaScan Off–Line Programmer” to registry

• Adds AdaptaScan OLP to the Windows Start menu

• Creates an AdaptaScan group containing icons for AdaptaScan
software and the Windows help file.

Registering AdaptaScan Software

Please take time to complete and send in the registration card you
received with AdaptaScan software.  Registering entitles you to:

• automatic notification of upgrades and revisions to AdaptaScan
software

• technical assistance

AdaptaScan Installation Files

File Function

AB.SYS User information provided during installation.

ADAPTASC.HLP AdaptaScan help system.

ADAPTASC.CNT AdaptaScan help contents.

ADPTSCN1,2,3.EDS Contains product information for DeviceNet Manager.

APPGUIDE.DBF Database containing example projects from the 
AdaptaScan Application Guide.

APPGUIDE.ID1 Index for database.

OLP.EXE AdaptaScan software executable.

SNEXxxxx.BIN Contains firmware code for Reader.

SNEXxxxx.INI Reader firmware update file.
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Each Reader is shipped with manufacturing firmware installed.  
You must download the release firmware prior to programming the
Reader.  All the devices on the same network must have the same
firmware installed. 

Note:  Download firmware with a computer connected directly to
the Reader configuration port.

!
ATTENTION:   Do not download firmware while the
scanner is on a DeviceNet master/slave network or you
will cause unrecoverable damage to the scanner.

Connect Configuration Cable

The configuration cable connects the configured communications
port (see Preferences, page 2–18) of the computer running
AdaptaScan software to the Configuration Port Connector of the
Reader.  Downloads may also be done through the  the Reader serial
communication ports when scanner protocol is selected (see page
8–6).

Configuration
Port Connector

Personal Computer

Configuration Cable
(Catalog No. 2755-NC48 Series B Reader

2755-NC43 Series A Reader)

9 to 25 Pin Adapter
may be required

9 Pin Male
D Connector

4 Pin Female
Circular Connector

Connect power, refer to Reader
User Manual (Publication 2755-837)

Make Power Connections

After connecting the configuration cable, you can connect power to
the wiring base.  The Reader User Manual (Publication 2755-837)
contains wiring diagrams and instructions.

Downloading Firmware



1–6 Installation

Publication 2755-838

Verify DeviceNet Address

The Reader is shipped with a default DeviceNet address of 63.
Verify that the DeviceNet address is still set at 63.

1. From the Windows Start menu, select Programs>AdaptaScan
OLP>AdaptaScan OLP.

The database dialog opens.

2. Click the New button.

The AdaptaScan project window opens.
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3. From the Communications menu, select Go-Online.

The Reader will be detected (if properly connected) and displayed
in the project window.

Note:  The Query dialog may be displayed when you go on-line
(depending on your preference settings).  Refer to page 2–19.

4. If the address displayed is not 63, change the Reader address by
clicking the Device button.

The Device dialog opens showing the current address.

If the Device is online but not in the project 
database, the following dialog is displayed:

If the Device is online and in the current project 
database, the following dialog is displayed:

5. Change the address and click Apply.
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Download the Firmware to the Reader

1. Check that Reader is properly connected to your computer (using
configuration cable) and has power applied (refer to page 1–5).

2. Select Preferences from the View menu.

SNEXaaaa.ini

3. Make sure the communications channel is set to  Configuration
Port.

4. From the Communications menu, select Go-Online.

The Reader will be detected (if properly connected) and displayed
in the project window.

Note:  The Query dialog may be displayed when you go on-line
(depending on your preference settings).  Refer to page 2–19.

5. From the Project window (see page 1–6), highlight the Reader
name and then click the Firmware  button.

The Open dialog is displayed allowing you to enter or browse to
the firmware file you want to download.

Select .ini
Firmware File

aaaa = Version Number

SNEXaaaa.ini

6. Select the firmware file you want to download and click OK.

The following messages appear as the firmware is downloaded.
Downloading will take several minutes.  During this time the
Module LED will flash red.

Resetting.  Please Wait . . .
Sending.  Please Wait . . .

7. The messages disappear when the download is complete.

You are ready to create a Reader configuration.
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This chapter contains the following sections:

Section Page

Running AdaptaScan Software 2–2

What is a Database File? 2–3

What is a Project? 2–3

Opening a Project 2–3

Project Window 2–4

AdaptaScan Dialogs 2–8

Saving a Project 2–12

Closing a Project 2–13

Deleting a Project 2–13

Entering Project Name, Description, and Baud Rate 2–17

Selecting Preferences 2–18

Help 2–20

Chapter Objectives
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AdaptaScan software opens like any other Windows 95 application.

To start AdaptaScan software:

1. From the Windows Start menu, select Programs>AdaptaScan
OLP>AdaptaScan OLP or double-click the AdaptaScan OLP
icon.

The AdaptaScan window opens with the database dialog:

The AdaptaScan Off-Line Programmer window is your workspace
for creating projects.

Running AdaptaScan
Software
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A database file provides a method of organizing projects.  Each
database file may contain one or more projects.  From the File menu
you can open existing or create new database files. 

Project File

Project File

Project File

Each Reader configuration is associated with a project.  Each project
contains one or more Reader configurations.  If using DeviceNet or
DH-485 communications, each project also defines one DeviceNet or
DH-485 network. 

Project File

Reader 1

Reader 2 Reader 3

Reader 4, . . .

There are two methods of creating a new project.

• From the Project menu, select New.

• Click the New Project  tool on the tool bar.

The Project window opens allowing you to define a Reader
configuration.

What is a Database File?

What is a Project?

Opening a Project
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Creating a Reader configuration starts with the Project window.  
All of the basic configuration options are accessed from buttons.
Selecting a button opens the corresponding dialog.

The buttons on the Project window are defined below.

Select: To:

Create a new Bar Code Reader configuration (Bar Code Reader 1, Bar
Code Reader 2, Bar Code Reader 3, ...) in the Project window.

Delete the selected Bar Code Reader configuration from the Project win-
dow.

Define label setups and symbologies for Reader operation.

Define a unique name and enter a description for the Reader.  Also de-
fines a DeviceNet address for the Reader.

Specify linear or raster scanning, how scanning is triggered, and accesses
the focus function.

Define when the Reader decodes data and what label is decoded.  Also
defines the inter-symbol timer and performance indicator parameters.

Define the operation for package detector, discrete inputs, discrete out-
puts, timer and ASCII trigger commands.

Define communication parameters (RS-232, RS-485/RS422) and proto-
cols (ASCII, DH-485, DF1) for the Reader’s communication ports.

Define match table, package and counter functions for decoded 
bar code data.

Define the format and content of messages sent to the host after bar
codes are decoded.

Transfer the configuration stored in a Reader to the currently opened
project in the AdaptaScan Software.

Downloads the highlighted configurations to the device or network.

View the operation of a single Reader or another Reader on the same
network.

Compare the Reader configuration within the project with the on–line
device.

Download new firmware to a selected Reader.

Project Window
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Existing Configurations

Any existing Reader configurations within the project are displayed
in the project window:

This display shows:

• Name - Reader name as specified on the Device dialog.
AdaptaScan software provides a default name of Bar Code
Reader 1, Bar Code Reader 2, etc.

• Device Name - read only field that displays the internally
configured name of the DeviceNet device (typically the catalog
number).

• Network ID - the node address of the device on the DeviceNet
network

Note:  When you go on-line with the software, any devices that are
not part of the configuration but are present on the network will be
added to the display.  Refer to Chapter 3 for a description of the
on-line functions.
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Status

The project window status icons display the status of the Reader
connections and configurations.

Connection
Indicates device is on-line Database

Indicates Configuration
is stored in the database

Device Icon
Graphic representing 

the type of device

Connection

When displayed, indicates a connection was made to the device:

• Yellow (default) indicates that the AdaptaScan software does not
have the information required to determine whether the device’s
configuration matches the configuration in the software database.

• Green appears after a Compare operation (see page 3–4) was
performed and the configuration of the on-line device matches the
database configuration.

• Red appears after a Compare operation (see page 3–4) was
performed and the configuration of the on-line device does not
match the database configuration.

Database

When displayed, indicates that a database configuration exists for the
Reader.    The color indications are the same as for the Connection
icon (see descriptions above) except the database icon will remain
yellow if a compare operation did not match the database.

Device Icon

Displays the icon associated with the device.  Here are some
common device icons:

= AdaptaScan Reader

= SDN Scanner Card

= PhotoEye photo-electric detector

= KFD  DeviceNet Personal 
           Computer Interface
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Information Lines

There are two areas on the project window that provide information
about a highlighted Reader configuration.

Connections per Reader /  Description Field Version Number / Compare Status

Connections Per Reader / Description

The total number of connections is displayed on the project dialog
along with a device description.  The description displayed is entered
on the Device dialog description field.

Each Reader has a minimum of 7 and a maximum of 64 connections.
A connection is an AdaptaScan object that moves data both
internally and between Readers.   For example, when Package Detect
is specified as the decode trigger, a connection moves data from the
package detect input to the decoder.   If the Package Detect is from
another Reader, each of the Readers use the connection object.

Important:   You will not be allowed to download a configuration
with more than 64 connections in a Reader.  A warning message is
displayed.  However, you can still read old databases with more than
64 connections.  You will need to reduce the number of items that
use connections before downloading the configuration.  Some items
that use connections are match fields, inputs and outputs.

Version Number / Compare Status

The first line shows the firmware version number of the Reader.  The
second line shows the compare status in a text format and matches
the status shown by the connection and database status icons (see
previous page).
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AdaptaScan software uses dialog boxes to request information and
set operating parameters.

Check Box

Drop-down List Box

Spin Control

Radio Button Command
Button

List Box

Text Box

To move around a dialog box:

• Move the mouse pointer to field and click the left mouse button.

• Or press TAB to move forward through fields and SHIFT+TAB to
move backward through fields.

• Or press the ALT key and the underlined letter of a field name.
For example, to move to the Laser Light field, press ALT+L .

Command Buttons

Rectangular areas in the dialog box that look like buttons you can
push.  When you click a command button, it presses like a real push
button.

Text Boxes

Text boxes are rectangular boxes in which you type text.  Sometimes
these boxes contain text or a value, sometimes they’re empty.

The mouse pointer changes to an I-beam when positioned over a text
box.  Place the pointer where you want to start typing and click the
left mouse button.  To replace all text, double-click in the text box
and type the new text.

AdaptaScan Dialogs
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List Boxes

This is a box with a list of items.  To select an item from a list, click
on the item.  A scroll bar appears beside the list box if there are more
items than can fit inside the box.

You can also use the arrow keys to select an item in the list.  Press
TAB until you get into the list box.  Then, press the UP or DOWN

ARROW keys to select the item you want.

Some list boxes let you select multiple items.  To select
non-consecutive items, click the first item, press and hold down the
CTRL key, then click the next item(s).  To select consecutive items,
click the first item, press and hold down the SHIFT key, then click the
last item.  To deselect a range, click the first item in the list.

Drop-down List Boxes

These are text boxes with an underlined down-arrow beside them.  If
you click inside the text area or click on the down-arrow, the list
drops down.  When you select an item from the list, the list
disappears.

Check Boxes

Square boxes that contain an X or are blank.  Check boxes are used
to select or clear an option.  An X in the box means the option is
selected.  A blank box means the option is not selected (it’s cleared).
Click the box to toggle the option on or off.

Radio Buttons

Circles that contain a solid dot or are blank.  Radio buttons come in a
group.  When you click one button in a group, it clears any other
option that was selected.  A solid dot in the button means the option
is selected.  When an option is not selected, the radio button is clear
(no dot).

Spin Controls

Small text boxes with up-down arrows at the right.  Spin controls are
used to select sequential numbers.  Click the up arrow to increase the
number or click the down arrow to decrease the number.   Or you can
click in the box and enter a number.
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Turn the tool bar view on or off from the View menu.
The tool icons provide shortcuts to the following menu items:

Move the toolbar to any side of the window or detach the toolbar and
place anywhere on your screen by clicking on and holding down the
mouse key while dragging the toolbar.

Bottom Position

Side WindowDetached

Default Position

AdaptaScan Tools
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Tool Summary

The following provides a brief summary of the AdpataScan tools.

Tool Icon
or Select 

from menu:
Description

For additional
information, 

see page:

Create New Database File >New
Creates a database file that will contain
project configuration files.

2–3

Open Existing Database File >Open
Opens window allowing you to select an
existing database file (.dbf) containing
project configuration files.

2–3

Open Selected Project Project >Open
Opens the project currently selected in
the AdaptaScan database file window.

2–3

Create New Project Project >New
Creates a new project within the
currently open database file (.dbf).

2–3

Go On-Line On-Line Tools >Go On-Line
Connects the programming computer to
the network.

3–2

Go Off-Line On-Line Tools >Go Off-Line
Disconnects the programming computer
from the network.

3–2

Upload Selected
Configuration into Project

On-Line Tools >Upload
Uploads the configuration stored in the
selected device to the current project.

12–3

Download Selected
Configurations to Network

On-Line Tools >Download
Downloads the selected Reader
configuration(s) to the Readers on the
network.

12–5

Open Monitor Window On-Line Tools >Monitor Opens on-line monitor window. 3–5

Compare Project
Configuration with 
On-Line Device

On-Line Tools >Compare

Compares the configuration database of
the currently selected Reader to the
actual configuration stored within the
Reader.

3–4

Cut Selection to Clipboard Edit >Cut
Removes the currently selected item
from the dialog or window and places
the item on the clipboard.

2–14

Copy Selection to Clipboard Edit >Copy
Copies the currently selected item from
the dialog or window and places the
copy on the clipboard.

2–14

Paste Clipboard Contents Edit >Paste
Pastes the last item placed on the
clipboard to the currently selected
location.

2–14

Print File >Print
Opens the print dialog that allows you to
print out an application report.

13–2

About AdaptaScan Software Help >About Off-Line Programmer
Opens a dialog showing the software
revision and serial numbers along with
other software information.

On-Line Context Help Help >Contents

When selected, displays a pointer.  this
pointer may be moved to an area on a
dialog or menu and clicked for help
about the item.

2–20
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Project information is saved as you configure each dialog box.
AdaptaScan dialog boxes have one or more of the following buttons.

Save Button  

Saves the dialog information.  If you close a dialog without saving,
you are prompted:

Changes have been made.  Do you want to save these changes 
before closing?

If you select No, all changes to the dialog (and associated dialogs
accessed from the dialog) are deleted.  Selecting Yes saves changes.

Apply Button  

Sends the dialog data to the specified Reader.  Use Apply when
making changes to the Scanner or Device dialogs while online.

OK Button  

Accepts the data within the dialog box.  The dialog information is
saved on the previous dialog (after selecting OK).

Saving a Project
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This section shows how to close a project. When closing a project,
use one of the following methods.  You are prompted to save
information if changes were made but not saved.

• With the project you want to close as the active window (or icon),
select Close from the Project menu.

• Or select Close from the control menu on the project window.

Control Menu Box

The Project window closes but the AdaptaScan Off-Line
Programmer window remains open.

With the project you want to delete as the active window (or icon),
select Delete from the Project menu.

You are prompted:

Are you sure you want to delete (Project Name).  
After deletion, there is no way to recover it.

Select Yes to delete the project.  When a project is deleted, all project
data is deleted from the program database and cannot be restored.
Select No to cancel the delete function.

Closing a Project

Deleting a Project
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The following items may be cut, copied and pasted within and
between database files:

• projects

• Reader configurations

• match functions

• message fields

• labels

• symbols (can’t be copied)

The cut, copy, and paste icons and menu selections will only be
available where they can be used.  Otherwise the icons will appear
grayed out.

Important:   Cutting or copying and then pasting a Reader
configuration is different from importing/exporting Reader
configurations.

When an individual Reader configuration is pasted into a project,
only the original Reader’s configuration dialog boxes are copied and
recreated in the new project.  Connections to and from the original
configuration are not recreated using Paste.  Paste is useful when you
need to make a configuration similar to an existing configuration in
the currently open project or another project.

When you need to make an exact copy of a configuration, copy and
paste the entire project in the AdaptaScan database dialog or use the
import/export functions (see next page).

Using Cut, Copy and Paste
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Using the import/export functions you can transfer exact copies of
Reader configurations between projects.  The imported/exported
configurations maintain the internal and external connections (see
page 2–7 for a description of connections).

To import a Reader configuration into a project:

1. Open the project you want to import the configuration file into.

2. From the File menu, select Import .

The Import Configuration dialog is displayed.

3. Enter the path>filename of the Reader configuration you want to
import (.cfg file).

4. Click Open to import the Reader configuration into the project.

Importing/Exporting
Reader Configurations
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To export a Reader configuration from a project:

1. Open the project that contains the file being exported.

2. Highlight the Reader configuration you want to export.

3. From the File menu, select Export.

The Export Configuration dialog is displayed.

4. Select the directory in which you want to place the Reader
configuration.

5. Click Save to export the Reader configuration.  The file will
appear in the directory with a .cfg extension.
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AdaptaScan software creates projects with a default name (Project 1,
Project 2, ...) and a default DeviceNet baud rate of 125K.  To rename
a project, enter a project description or change the baud rate, open
the project you want to edit.  With the project as the currently active
window, select Edit  from the Project menu.

The Project dialog opens.

Enter a new project name and description.  Select a baud rate that is
compatible with the DeviceNet network on which the Readers are
communicating.

Entering a Project Name,
Description, and Baud Rate
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The Preferences dialog allows you to specify options related to
computer communications.  With the project as the currently active
window, select Preferences from the View menu.

The Preferences dialog opens.

Select: To:

DeviceNet Select DeviceNet to communicate with a Reader through a
DeviceNet network.  A DeviceNet communications card and
driver software must be installed on your computer.

Configuration Port Specify a direct connection to a Reader’s configuration port.
This is the default setting.

Port Specify the communications port on your computer used to
configure the Reader.  The options are COM1 through COM9.

Timeout 
(Seconds)

Enter the amount of time your computer will wait for a response
before a timeout occurs.  Enter a value between 1 and 60, the
default is 10.

NAK Retries Enter the number of times your computer will accept a NAK
(negative acknowledgement) before a communications fault
occurs. Enter a value from 0-20, the default is 2.

Timeout Retries Enter the number of times your computer will attempt to estab-
lish communications after a timeout. Enter a value from 0-20,
the default is 2.

Preferences
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Network Query Preferences

The Query dialog specifies the network addresses that are checked
when the AdaptaScan software checks the network.  By specifying
just the addresses that need to be read, you can speed up network
operations.

The Query dialog is displayed when you:

• select Query from the View menu

• select Go On-Line from the Communications menu

• select Refresh from the Communications menu

Specify the network address you want to check:

Select To:

All Check all addresses (0 to 63).

Displayed Check only the connections displayed in the project window
(see page 2–4).

Selected Check only the connections displayed and highlighted in the
project window (see page 2–4).

Specified Check only the addresses listed.

To disable the Query dialog from displaying when you use on-line
tools, uncheck the checkbox on the bottom of the dialog.  You can
still access the dialog from the View menu after unchecking the box.
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Both general and context sensitive Help is available.  Access general
Help topics by choosing Contents from the Help menu.

Help feature How to use it

Contents Tab Choose to display the help content books.

Index Tab Choose to see an alphabetical list of topics.

Find Tab Choose to search for topics by keywords.

Access context sensitive help by choosing the Help button available

on all dialogs.  Or click the Help tool  and then the item you

want help for.

Help
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This chapter describes AdaptaScan online communications and tools.

Section Page

Going On-Line 3–2

Using the Compare Tool 3–4

Monitoring a Reader 3–5

Displaying LED Status 3–6

Displaying Counters 3–7

Displaying Scanner Performance 3–7

Displaying Bar Code Labels 3–9

Displaying Hardware Information 3–9

Chapter Objectives
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The Go On-Line command establishes communications between the
AdaptaScan software and DeviceNet network using the
communication channel specified on the Preferences dialog (see
page 2–18).

To go on-line with AdaptaScan software:

1. Click the Go On-Line icon or select Go On-Line from the
Communications menu.

The project window will display the devices on the network along
with their catalog number and address.

Note:  The Query dialog may be displayed when you go on-line
(depending on your preference settings).  Refer to page 2–19.

Note:  If you are connected to the DeviceNet network using the
Reader configuration cable, only AdaptaScan Readers on the
network are identified and displayed.  When connecting using a
DeviceNet communications card and driver software on your
computer, all DeviceNet nodes on the network are identified and
displayed.

2. Highlight individual readers in the list to display the currently
loaded firmware revision and their configuration status.

Going On-Line

Go On-Line
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When going on-line:

• You can only be on-line with one project at a time.  Use the Go
Off-Line  command (Communications menu) when you want to
switch to another project.

• Upload, Download, Monitor  and Compare functions are only
available for AdaptaScan Readers having the same major version
number as the AdaptaScan software (firmware version 11.XX or
greater)

• The Firmware  button, for downloading firmware to a Reader, is
only available when the communications channel is set for
Configuration Port (direct connection using configuration cable).

• Use Refresh (Communications menu) to query the network and
update the display.

• Use Query (View menu) to display the Query dialog.   The Query
dialog allows you to specify the network addresses read when
on-line functions are used.  Refer to page 2–19.  By only
checking the addresses that are required, you can increase the
speed at which network operations occur.
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The compare tool compares the calculated Cyclic Redundancy
Check (CRC) of the configuration stored in the project database with
the CRC of the configuration stored in the Reader.  Compare is
useful when checking if a Reader’s configuration has been changed
to determine if an upload or download is necessary.

Note:  Reader configurations cut and copied between projects may
not match when compared due to differences in the label
configurations between projects.

To use compare:

1. Make sure the software is on-line by clicking the Go On-Line
icon or by selecting Go On-Line from the Communications
menu.

Note:  The Query dialog may be displayed when you go on-line
(depending on your preference settings).  Refer to page 2–19.

2. Select the Reader configuration you want to compare with the
actual configuration stored within the Reader.

3. Click the Compare tool icon or select Compare from the
Communications menu.

Connection Icon Database Icon

If the Reader configuration has been compared and does not match
the configuration stored in the Reader, the connection icon appears
red.

If the Reader configuration has been compared and  matches the
configuration stored in the Reader, the database and connection icons
appear green.

If a Reader configuration has not been compared to the configuration
stored in a Reader, the database and connection icons appear yellow.

Using the Compare Tool

Go On-Line

Compare
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The Monitor window displays the current operational status of a
Reader.

To monitor a reader:

1. Make sure the software is on-line by clicking the Go On-Line
icon or by selecting Go On-Line from the Communications
menu.

2. Open the monitor dialog by selecting the Monitor button on the
main Project dialog or by selecting Monitor  from the
Communications menu.

The monitor window is displayed:

7003063081

7003063081
7003063081

Package 1:90
Match1: 30

Starts and Stops monitoring.

Displays hardware information about Reader.

Closes the dialog.

Resets counter to configured initial value.

☞ The more information
monitored (the more check 
boxes selected) the slower the 
monitor window is updated.

3. Select the items you want to monitor.

Monitoring a Reader

Go On-Line
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The LEDs area of the monitor display shows the status of specific
Reader operations.  Select the LEDs check box to display the status
of Reader operations.  The following tables show the LED
conditions and their meanings.

!
ATTENTION:    Depending upon the amount of
information being monitored and network response
times, the LED status indicators may not reflect the
current status of the Reader.  Do not rely on these
status indicators for important operating decisions.

On Symbol

Condition Indication

Yellow Bar code symbol is being scanned and decoded.

Flashing Bar code symbol is being read at less than 100% rate.

Off Not reading a bar code symbol.

Trigger/Read

Condition Indication

Yellow Decoder trigger is on.

Green Valid bar code symbol read.

Off No trigger or valid bar code symbol read.

I/O 1 and I/O 2

Condition Indication

Yellow Corresponding input or output is in an On (closed contact) state.

Off Corresponding input or output is in Off (open contact) state.

Network
Condition Indication

Green Normal DeviceNet operating state.
Flashing Green Communication link established but no data transfer.
Red DeviceNet communication fault detected.
Flashing Red One or more DeviceNet devices are not responding.  Reader may

not be able to perform all of its configured functions.
Off No DeviceNet communications established.

Laser On
Condition Indication

Yellow The scanning beam is On (active).

Off The scanning beam is Off (inactive).

Module
Condition Indication

Green Normal operating condition.  Power is applied to the Reader and no
faults have been detected.

Flashing Green Power-up initialization sequence or Reader is not configured.
Red Processor fault (unrecoverable).➀
Flashing Red Minor fault (recoverable).  Occurs when downloading new firmware.
Off No power applied to Reader.➀

➀   For reference only.  These indicators will not be visible if the condition causing them
occurs.

Displaying LED Status
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The Counter area of the monitor display shows the values stored in
the package and match entry counters.  Select the Counters check
box to display the counter values.

☞ Click the Reset Counters 
button to reset counters to 
initial value.

The metrics area of the monitor display shows either:

• the decode margin (see definition below).

• the number of decodes during a trigger period (Counts)

Select either Dial or History

Select either Margin or Counts

You can display the Margin or Count parameters in either a Dial or
History format.

Dial History

Scanner metrics are useful during:

• Initial Setup for making  minor adjustments to the scan beam on
the Scanner dialog.

• Normal operation to identify small decreases in performance.  
For example, if the number of reads drops significantly, label
quality may have degraded or the scan window may require
cleaning.

Displaying Counters

Displaying 
Scanner Metrics
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Margin

The scanner metric for margin is a measure of how clearly
distinguishable the different element sizes (bars and spaces) are in a
symbol.  Margin is calculated every time a symbol is decoded.  The
margin result is the tolerance remaining before the AdaptaScan can
no longer differentiate between wide and narrow elements.

Several factors affect the margin, including how well the
AdaptaScan is focused and the quality of the symbol.  Assuming that
the AdaptaScan is properly focused, margin can be used for an
indication of trends in label quality.  This is especially true for ink jet
symbols on cardboard cartons where low margins can occur because
of increasing ink spread.

Margin values may be returned in a host message (see page 10–2) or
used to trigger an output if the margin value falls below a user
defined level (see page 7–8).
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Select the Bar Code Labels check box to display labels as they are
decoded.  The data from each label displays on a separate line.  Any
data formatting is not displayed.

123098
456987
051997
051997
071996

Select the Hardware Info button to display information about the
Reader such as series/revision, firmware version, boot version, and
catalog numbers of Reader and AdaptaScan software.

Displaying Bar Code Labels

Displaying 
Hardware Information
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This chapter provides step-by-step instructions on how to configure
the Reader to scan and decode UPC-A symbols.  This section
acquaints you with basic configuration and operation of the Reader
by stepping through a sample configuration.

Section Page

Configuration Description 4–1

What You Need 4–2

Connecting Power 4–3

Connecting the DL10 4–3

Installing the Reader 4–5

Connecting the Configuration Cable 4–5

Running the AdaptaScan Software 4–6

Downloading Firmware 4–9

Setting Up the Communication Port 4–7

Creating a New Project 4–8

Creating a New Reader Configuration 4–8

Defining the Label Setup 4–11

Configuring the Scanner 4–13

Positioning the Reader 4–13

Focusing the Reader 4–15

Configuring the Decoder 4–16

Configuring the Discrete Outputs 4–17

Setting the Timer 4–21

Setting the Serial Port 4–22

Defining a Package 4–19

Configuring Message Output 4–23

Downloading the Configuration 4–25

Monitoring Reader Operation 4–26

Dataliner Operation 4–26

The sample configuration reads UPC-A labels.  The Reader will
activate outputs 1 and 2.

• Output 1 energizes when a label is read.

• Output 2 energizes when a no-read occurs.

The monitor display shows the status of the Reader operation.

An optional Dataliner DL10 display receives and displays decoded
bar code data from the Reader’s RS-232 port.

Chapter Objectives

Configuration Description
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The sample configuration requires the following items.  The
Dataliner� DL10 and cable are optional.  The DL10 is a slave
message display that displays any ASCII data that it receives from
the Reader.  You can use the configuration software monitor function
to view decoded data if a DL10 or other display device is
unavailable.

Personal Computer
Running Windows 95 or Windows NT

AdaptaScan Bar Code Reader
(Catalog No. 2755-SN3, -SN5, -SN8)

Configuration Cable
(Catalog No. 2755-NC48 Series B Reader,

2755-NC43 Series A Reader)

AdaptaScan Software
(Catalog No. 2755-ASN)

9-to-25 Pin Adapter
Required for Computers with 
25 Pin Communication Port.  

(Purchase Locally)

Test Bar Code Symbols
(Publication No. 2755-940)
Provided with this Manual

Power Supply
(Catalog No. 2755-PW46, -PW47)

Wire & Small Slotted Screwdriver
For Connecting Power Supply

AdaptaScan Wiring Base
(Catalog No. 2755-NB40, -NB41)

DL10 Communication Cable
2 Conductor Shielded Cable
(Belden 8303 or Equivalent)

Dataliner
(DL10 with 

120V Power Cord)

Optional Items

What You Need
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Before configuring the Reader, you must connect the
communications cable and provide power.

Power Connections

Connect the power supply to the Reader wiring base as shown below.

Note:  This example uses unshielded wires for power connections.
Make sure you use shielded cable for the final installation as
described in the AdaptaScan Bar Code Reader user manual.

V+

Can_H

Shield

Can_L

V-

Reader Wiring Base

120V AC Wallmount
Power Supply

(Catalog No. 2755-PW46)

+ -GND
230V AC Desktop 

Power Supply
(Catalog No. 2755-PW47)

Verify the connection by applying power to the wiring base and
observing the polarity LED.  The LED should be green.  If the LED
is red, the polarity needs to be reversed.  Disconnect power from the
wiring base until the Reader is installed.

Connecting Power
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Use a two conductor shielded cable to connect the DL10 data display
to the RS-232 port of the Reader.  The DL10 is optional.  If you
don’t have a DL10, you can still view decoded data using the
configuration software monitor function.

Note:  The data viewed on the monitor window does not necessarily
correlate with the data sent out of the serial port.  The monitor
window displays unformatted data while the serial port data may be
formatted to contain other data such as replacement strings, source
ID, etc.

Tx
GND

Reader Wiring Base

RS-232 Port

Dataliner
Communications Port

Dataliner DL10
Message Display

Connect to 120 VAC
Power Source

Use Belden 8303
or equivalent

Connecting the 
DL10 Slave
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Carefully position the Reader on the wiring base.  You don’t need to
tighten the screws for this sample application. 

Screws 
4 Locations
Don’t Tighten Screws

Wiring Base
Insulating
Cover

Use the configuration cable (Catalog No. 2755-NC48  Series B,
2755-NC43 Series A) provided with the AdaptaScan software to
connect the computer’s communication port to the Reader’s
configuration port.  If the computer has a 25-pin connector, you need
a 9-to-25 pin adapter.

Configuration
Port Connector

Personal Computer

Configuration Cable
(Catalog No. 2755-NC48 or -NC43)

9-to-25 Pin Adapter
may be required

9 Pin Male
D Connector

4 Pin Female
Circular Connector

Power source required
See Reader user manual

(Publication No. 2755-837)

Apply power to the Reader.  On initial powerup, the Reader performs
a series of self-diagnostic tests and LED tests (all LEDs flash).
Refer to table page 3–6 for a description of the LED indicators.
When the Module LED flashes and turns a steady or flashing green,
the powerup sequence is complete.  The complete powerup sequence
takes a few seconds.

Installing the Reader

Connecting the
Configuration Cable

Power-up Sequence
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If you haven’t already done so, install the AdaptaScan software.
Software installation procedures are described in Chapter 1. 

After installing the software, the AdaptaScan OLP group icon
appears in the Program Manager window.

To run the AdaptaScan software:

1. From the Windows Start menu, select Programs>AdaptaScan
OLP>AdaptaScan OLP.

The AdaptaScan window opens.

2. All configurations occur within the AdaptaScan window.  Use the
dialog buttons and/or menu selections to access the AdaptaScan
software operations.

Running the
AdaptaScan Software
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The Reader configuration port is set for 9600 Baud and cannot be
changed.  This port is set by default to communicate with the first
port that is available on your computer. 

If your computer is using a different communication port, change the
port by selecting Preferences from the View menu.

To change communication port settings:

1. Select Preferences from the View menu.

The Preferences dialog opens.

2. Select the communications port connected to the Reader.

3. Make sure that Configuration Port  connection is selected.

4. Click OK  to save changes.

Note:  The Reader can also be connected to a Reader through a
DeviceNet network connection.  A DeviceNet communications card
and driver software must be installed on your computer.  If you are
using DeviceNet Manager Software (Catalog No. 1787-MGR) to
connect to an AdaptaScan Reader in a network, refer to the user
manual (Publication No. 1771-2.29).  Select DeviceNet connection
on the Preferences dialog when using a DeviceNet network
connection.

Communications Setup
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Reader configuration dialogs are accessed from the Project menu. 

To create a project:

Select New from the Project menu or click New on the AdaptaScan
window.

The Project window opens with the default name of Project 1.

To create a Reader configuration:

From the Project 1 window, click the New button.

An application is created with the default name Bar Code 
Reader 1.  Applicable dialog buttons are enabled.

Creating a Project

Creating a New
Reader Configuration
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If the Reader is being operated for the first time (out of the box), you
must download operating firmware.

The Reader is shipped with a default DeviceNet address of 63.

To download operating firmware to the Reader:

1. From the Communications menu, select Go-Online.

The reader will be detected (if properly connected) and displayed
in the project window.

Note:  The Query dialog may be displayed when you go on-line
(depending on your preference settings).  Refer to page 2–19.

Note Address

2. From the Project window, highlight the Reader name and then
click the Firmware  button.

The Open dialog is displayed allowing you to enter or browse to
the firmware file you want to download.

SNEXaaaa.iniSelect .ini
Firmware File

aaaa = Version Number

Downloading Firmware
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3. Select the firmware file you want to download and click OK .

The following messages appear as the firmware is downloaded.
Downloading will take several minutes.  During this time the
Module LED will flash red.

Resetting.  Please Wait . . .

Sending.  Please Wait . . .

4. The messages disappear when the download is complete.

You are ready to create a Reader configuration.
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This section shows how to specify what type of label(s) the Reader is
expected to decode.  For the sample configuration, the Reader is
expected to decode an UPC-A symbol.  

To define the bar code label setup:

1. From the Project 1 window, click the Labels button.

The Bar Code Labels dialog opens.

2. Click New to define a new label.

The Bar Code Labels dialog opens with a default name of Label
1 for the label setup.

3. Click the New button to specify the symbols the Reader expects
to find on a label.

Defining the Label Setup
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The Bar Code Label Symbol dialog opens.

4. Make changes as shown below and then click OK .

 1. Change
Name to UPC-A

2. Select 
UPC-A

3. Click OK

The Bar Code Label dialog shows UPC-A in the Symbols list.  If
other symbologies were expected on the label, you would define
them in the same way.

5. Click OK  to save the label definition.

The bar code label, Label 1, appears in the Bar Code Labels list.

6. Click Save and then Close to save and close the label definition.

You return to the Project 1 window.
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This section configures the Reader for linear scanning. 

Configure the scanner:

1. From the Project 1 window, click the Scanner button.

The Scanner dialog opens.

Select
Always On

Select
Linear

2. Select Always On from the Laser Light list.

Note:  Only use the Always On setting for initial setup.  When
installed in an application, you should set Laser Light to
Triggered.

3. Select Linear  under Scanner options.

Before using the focus function, you must position the Reader so
that the scan beam crosses a UPC–A label.  You can use the test
card (Publication 2755-940).

Configuring the Scanner
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Position the Reader:

1. Place the test symbol approximately 12 inches (.3 meter) in front
of the Reader so that the scan beam crosses the symbol.

Test Card

Observe 
On Symbol 

LED
Make sure symbol
is slightly skewed.

2. Observe the ON Symbol LED on top of the Reader.  When the
LED is illuminated, the Reader is scanning an enabled
symbology.

Note:  The ON Symbol LED may not light (bar code symbol not
read) if the Reader is not focused correctly or the symbology is
not configured.

Adjust scan line elevation and width:

If the scan line does not completely cross the UPC-A symbol, adjust
the scan line elevation and width.

1. Increase or decrease the scan width and elevation.

2. Click Apply  to send the new settings to the Reader, wait for the
changes to take affect.

3. Repeat adjustments until the scan line is crossing all of the
symbol.
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Use focus:

1. Click the Focus button to open the Focus dialog.

Select this
check box

2. Select the Set to Suggested Position check box and then click the
Start button.

As the Reader adjusts the focus from the shortest to longest focal
length, you may notice the scan beam change width.  When
completed, the display shows the focus margin profile with
markers at the minimum and maximum range (red lines) and the
recommended setting (green line).  The recommended setting is
at two-thirds of the margin up from the minimum setting.  The
focus is automatically set at the recommended range units.

Margin Profile

Minimum Limit

Maximum Limit

Recommended Setting

3. Click OK  to return to the Scanner dialog.

4. Click Save to save the scanner settings, then click Close.

You return to the Project 1 dialog.

5. ON Symbol LED illuminates.
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This section shows how to specify when and what labels are to be
decoded by the Reader. 

To configure the decoding parameters:

1. From the Project 1 window, click the Decoder button.

The Decoder dialog opens.

The label name Label 1 should appear in the Bar Code Label list.
If the name doesn’t appear, you need to redefine the label setup.

Since the project contains a single Reader configuration, Bar
Code Reader 1 should appear as the trigger source for decoding.

1. Select  Label 1

2. Select 
   Bar Code Reader 1

3. Select Timer

2. Select Timer  from the Input list.  Timer allows the Reader to
trigger decoding without an external input (package detect).  This
is useful for simulating a package detector during setup.

3. Click Save and then Close to save the decoding parameters.

You return to the Project window.

Configuring the Decoder
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The sample configuration turns on output 1 when a symbol is read
and turns on output 2 when a no-read occurs. You can turn on these
outputs using the match table and package output definitions.

To configure the discrete outputs:

1. From the Project 1 window, click the Match Table button.

The Match Table dialog opens.

2. Click the New button to define a match function.

The Match Functions dialog opens with a default Match Function
Name of Match 1.

2. Click Here to 
Display Label Setup for
Bar Code Reader 1

1. Select Match Entry

3. Enter Match Rule:

4. Check Match
  Exactly Box

5. Make sure Disable
is not selected

3. Select Match Entry  from the Functions list.

4. Select Bar Code Reader 1 from the Symbol Source box.

Configuring 
the Discrete Outputs



4–18 Getting Started

Publication 2755-838

The label setup defined for Bar Code Reader 1 is displayed in the
Bar Code Labels & Symbols box.

Select the UPC-A 
Label Setup

5. Select UPC–A from the Bar Code Labels & Symbols box.

6. If you want the Reader to match a specific label, enter the symbol
data as the Rule.

7. Click the Outputs button to specify which output to activate
when a match occurs.

The Match Function Output dialog opens.

8. From the Available Outputs: list, select Discrete Input/Output 1
and then click the Add >> button.

The Output To: list shows that Discrete Input/Output 1 is assigned
to the match function.

9. Click OK  to return to the Match Function dialog.

10. Click OK  to return to the Match Table dialog.

You have completed the configuration of the match table.

☞ Or double-click an available 
output to add it to the list

 of outputs.
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This section shows how to define a package based on the match
entry definition (Match 1).

1. From the Match Table dialog, click the Package button.

The Packages dialog opens.

2. Click the New button.

The Packages dialog opens with the default Package Name,
Package 1.

Select
No-Read Package

Select Match 1

3. From the Mode list, select No-Read Package.

4. Highlight Match 1 in the Match Functions box.

5. Click OK .

Defining a Package
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The Packages dialog opens with the created package definition.

Package Definition

6. Select the Output To button.

The Package Outputs dialog opens.

7. From the Available Outputs: list, select Discrete Input/Output 2
and then click the Add >> button.

The Output To: list shows that Discrete Input/Output 2 is assigned
to the package definition.

8. Click OK  to return to the Packages dialog.

9. Click OK  to return to the Match Table dialog.

10. Click Save and then Close.

You return to the Project 1 window.

☞ Or double-click an available 
output to add it to the list

 of outputs.
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This section configures the timer that was selected as the trigger
source for decoding and scanning. 

1. From the Project 1 window, click the Input/Output  button.

The Input & Output dialog opens.

Select Timer

2. Select Timer  and then click the Edit  button.

The Timer dialog opens with a default timer name of Timer.

Cyclic Timer
On 1 Second
Off 1 Second

The dialog shows that the timer is set for cyclic operation, with a
specified On Time and Off Time.

3. Click OK  to exit and return to the Input & Output dialog.

4. Click Save and then Close to save the timer definition.

You return to the Project 1 window.

Setting the Timer

☞ Or double-click on Timer to
open the Timer dialog.
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This section describes how to configure the Reader RS-232 port
(inside wiring base).

To configure the serial port:

1. From the Project 1 window, click the Serial Port button.

The Serial Port dialog opens.  Verify the following settings:

1. Select Terminal

2. Select
9600 Baud

4. Select  
No Parity, 
8 Data and 
1 Stop Bit.

3. Select 0 message
length (sends all
data regardless of
length).

5. Select 
RS-232 Connection

2. Click Save and then Close to save the serial port configuration.

You return to the Project 1 window.

Note:  If using the DL10 Dataliner, make sure that the DL10
configuration is set to match the Reader serial port configuration:

Terminal Protocol
9600 Baud
No Parity
8 Data Bits
1 Stop Bit

Setting the
Serial Port
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This section shows how to configure the Reader to send bar code
data out the RS-232 port to the Dataliner message display.

1. From the Project 1 window, click the Message button.

The Message dialog opens.  Make the following edits:

1. Select Enable

2. Select Timer

2. Click the New button.

The Message Field dialog opens.  Make the following edits:

1. Select Bar
Code Reader 1

2. Select UPC–A
Symbol

3. Leave blank

4. Check Match
Exactly box 5. Make sure Disable

is not selected

Note:  If you leave the Find String blank and select Match Exactly,
all characters will be matched.

Configuring 
Message Output
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3. Click the Edit  button.

The Message Field Edit dialog opens.  Make the following edits:

1. Set length to 14

2. Leave blank

3. Enter NO–READ
as the Fail string

Note:  If you leave the Pass String field blank, all of the decoded bar
code data is placed in the message string.  You could enter a string
like Good Read that would be placed in the data message whenever
a UPC label is decoded.  The Fail String NO-READ is placed in a
message when a label is decoded that does not match the content of
the Find String (see previous page).

4. Click OK  to exit and return to the Message dialog.

5. Click the Format button on the Message dialog.

The Message Format dialog opens.  Make the following edits:

1. Enter \n as
the header.

2. Enter \r as
the trailer.

3. Make sure
Serial Port
is selected.

Note:  \n = Line Feed, \r = Carriage Return

6. Click OK  to exit and return to the Message dialog.

7. Click Save and then Close to save the message definition and
return to the Project 1 window.
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This section shows how to download the Bar Code Reader 1
configuration to the Reader.

Verify the computer to Reader connections described on page 4–5.

To download the Bar Code Reader 1 configuration:

1. Select Go On–Line from the Communications menu.
The Reader will be detected and displayed in the Project window:

2. From the Project 1 window, verify that Bar Code Reader 1 is
selected.

3. Set the Reader address by clicking the Device button.

The Device dialog opens allowing you to change the address.  
The Reader is shipped with a default address of 63.

4. If you want to change the address, click Apply  to send the
address to the Reader.

It will take a few seconds for the address download to occur.

5. Click Save and then Close.

You return to the Project 1 window.

6. With the Reader configuration highlighted, click the Download
button to download the configuration to the Reader.

The following messages appear during the download.

Resetting.  Please Wait . . . 
Sending.  Please Wait . . .

When the download is complete, the messages disappear.

7. Click the Scanner button and select Triggered for the laser light
control.  Click Apply  to send the changed setting to the Reader.

8. The Reader should now be turning the scan beam on and off at 1
second intervals.

Downloading 
the Configuration
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The Monitor window shows the status of the Reader while scanning
and decoding bar code labels.

To use the monitor display:

1. From the Project 1 window, click the Monitor  button.

The Monitor dialog opens.

2. Select the LED, Metrics, Counters, and Bar Code Labels check
boxes.  Click the Start button to begin monitoring.

7003063081
7003063081
7003063081

Package 1:90
Match1: 30

3. Move the bar code label to various distances and positions.
Observe the results.  The Match counter increments each time the
symbol is read.  Notice that when you move the symbol out of the
scan beam, the Package counter (set for no reads) increments
once for every trigger.

4. Click the Close button to exit the Monitor dialog and return to the
Project 1 window.

Monitoring 
Reader Operation
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The DL10 message display should be displaying the UPC–A
symbols as they are decoded.  Each symbol is preceded with a line
feed (\n header) and terminated with a carriage return (\r trailer).

����������

����������

Dataliner Operation
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This chapter shows how to define scanner setup for the Reader.

Section Page

Laser Caution 5–1

Scan Patterns 5–2

Scan Adjustments 5–3

Setting up the Scanner 5–4

Focus Options 5–6

Setting the Focus 5–7

The Reader uses a low power visible laser diode.  As with any bright
light source, you should avoid staring directly into the beam.
Momentary exposure to a CDRH Class II laser is not known to be
harmful.

!
ATTENTION:    Laser Light: do not stare into the
beam.  660nm laser diode 1.0 milliwatt max output
Class II laser product.

Chapter Objectives

Laser Caution
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The Reader performs both linear and raster scanning.

Linear Raster (with flyback)

The orientation of the Reader to the labels usually determines the
type of scanning required.

Picket Fence Orientation Step Ladder Orientation

Reader Mounted
Above Conveyor

Reader Mounted
On Side of Conveyor

Reader Mounted
Above Conveyor

Reader Mounted
On Side of Conveyor

When the labels pass the scanner in a step ladder orienta-
tion, a linear scan is preferred.  The beam scans the label as
it passes.  The number of scans per label depends on the
label size, scan rate, and the conveyor speed.

If a linear scanning Reader is aligned parallel with the long axis of
a picket fence label, the same strip of label is scanned repeatedly.
Because of this, picket fence applications usually use a raster
scan.

Scan Patterns



5–3

Publication 2755-838

Online adjustments can affect the width and location of the scan
beam.  Use these adjustments to make minor changes to an
application, not to compensate for improper installation.

See the AdaptaScan User Manual for descriptions of Usable Beam
Width, Scan Angles, Skew/Pitch/Tilt and Apparent Element Width.

• Scan Width – adjusts beam width.

Scanner Optical Scan Angles➀

2755-SN3 22� to  72�

2755-SN5 20� to 50�

2755-SN8 18� to 30�
➀ Usable scan angle is 80% of the optical scan angle.

• Elevation (linear scanning only) – adjusts the vertical angle at
which the scan beam exits the Reader.

Elevation can be adjusted
�10� from center line.

Center Line

Variable

• Upper and Lower Angles (raster scanning only) – adjusts the
high and low raster angles.  The range for each angle is 10 to
-10�.  The lower scan angle must be equal to or less than the
upper scan angle.

Lower Scan Angle –10� 
from center line.

Center Line

Upper Scan Angle +10� 
from center line.

• Flyback (raster scanning only) – quickly returns the scan beam
from the lower raster angle to the upper raster angle.

Flyback

Scan Adjustments
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The Scanner dialog configures the operation of the Reader scan
beam.  Open this dialog by selecting the Scanner button on the main
Project window.

Opens the Focus Dialog
which allows automatic
or manual adjustment of
focal distance.

Applies settings to a Reader
that is online. 

Note:  Settings adjusted
online using Apply are lost
when the Reader is powered
down.  To retain changed
settings after power down,
make sure you send the
configuration to the Reader
(Click Download on Project
window).

Laser Light

Determines when the scan beam is turned on and off.

Select: To:

Always On Set scan beam on continuously.  This setting may be useful
during initial setup.

Triggered Turn on the scan beam when a trigger signal is received.  The
scan beam turns off after decoding all the symbols defined for a
label.

Always Off Turn the scan beam off.  Use this setting during routine mainte-
nance or installation.

Scanner

Defines the operating characteristics of the scan beam.

Select To
Linear Scan a single horizontal beam back and forth across a bar

code symbol.

Raster Move a horizontal scan beam up and down over a bar code
symbol.

Setting up the Scanner
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Linear Scan Parameters

Select: To:

Scan Width Change the width of the scan beam by varying the angle at
which the beam exits the Reader.   Select from 30, 40, 50, 60,
70, 80, 90 or 100% of the maximum scan angle.  The maxi-
mum scan angle depends on the type of Reader.

Elevation Set the vertical angle at which the scan beam exits the Reader.
The elevation ranges from +10 to -10 degrees from the center-
line of the scan window.

Raster Scan Parameters

Select: To:

Scan Width Change the width of the scan beam by varying the angle at
which the beam exits the Reader.   Select from 30, 40, 50, 60,
70, 80, 90 or 100% of the maximum scan angle.  The
2755-SN8 scan beam cannot be set to less than 50% due to
CDRH requirements.

Upper Angle Set the upper scan angle of the raster pattern.  Values range
from +10 to -10 degrees from the centerline of the scan win-
dow.

Lower Angle Set the lower scan angle of the raster pattern.  Values range
from +10 to -10 degrees.  The lower scan angle must be less
than or equal to the upper scan angle.

Increment Set the speed of the raster.  Select a value between 0.1 and 1
degree per scan.

Flyback 
Control

Enable flyback which quickly returns the scan beam from the
lower raster limit to the upper raster limit.
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Focus

The scanner dialogs provide a focus option.

Focus Setting

Preset Focus

Four preset read ranges allow for easy replacement of an existing
scanner.  See Appendix B for read ranges.

Manual Focus

Manual adjustment of the read range is available in increments of 10
units (0 to 255 units) using the spinner controls or a value can be
typed in.  Manual focus provides a trial and error process for finding
the best performance for a given application.

Autofocus

This feature automatically adjusts the scan beam focal distance for
the best margin for the symbol appearing at a fixed position.  When
focus is initiated, the Reader continuously adjusts the focal distance
as a symbol is scanned (from minimum to maximum).   The Reader
displays and records the margin at each focal length.  The focus is set
at the point two-thirds of the way between the minimum and
maximum acceptable focus range units.

Focus Options
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Open the Focus dialog by clicking the Focus button on the Scanner
dialog.

Focus

Displays the status of the autofocus.

Select To

Set to Suggested
Position

Immediately set the focal distance to the focus position deter-
mined by the autofocus function (without clicking Apply).

Start Initiate the autofocus function.

Focus Range Units

Displays the current focal range from 0 to 255 units, where 0 is the
minimum focal distance and 255 is the maximum.

Preset

Shows one of 4 preset focal ranges that correspond (approximately)
to Allen-Bradley Bar Code Scanners (Cat. No. 2755-LD4, -LD8).
See Appendix B.

Select To

A Set the focal distance to 20 units.

B Set the focal distance to 104 units.

C Set the focal distance to 158 units.

C+ Set the focal distance to 180 units.

None Disable the preset focal distance option.

Setting the Focus
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To use focus:

1. Click the Focus button on the Scanner dialog.

The Focus dialog opens.

2. Position a slightly skewed label (about 20�) in the center of the
expected depth of field.  Refer to the instructions in Chapter 3 for
assistance.

3. Click the Start button to initiate the focus.  It takes several
seconds for focus to complete its scanning.

The Focus dialog displays the results of the focus after the Reader
scans the label at different focal distances.  For a description of
the results, see page 4–15.

4. Make manual adjustments to the focal distance to optimize
Reader performance.
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This chapter describes the dialog boxes that define a label setup.  A
label setup defines the label contents the Reader is expected to read.

Section Page

Helpful Hints 6–1

What is a Label? 6–2

What is a Label Setup? 6–3

Managing Bar Code Labels 6–4

Defining a Bar Code Label 6–5

Used By Dialog 6–7

Defining Symbols for a Bar Code Label 6–8

Selecting Symbologies for a Bar Code Label 6–10

When defining a label setup:

• Enable only the symbologies the Reader is expected to scan to
increase the Reader’s response rate.

• Define as many parameters as you can for each label and
symbology to prevent the possibility of a misread.

• You can define label setups at any time (before or after other
Reader settings).  However, label setups are assigned to a Reader
using the Decoder dialogs.  It may be easier to create the label
setups prior to defining the operation of the decoder.

• For initial setup use the default settings when possible. When a
configuration is working, change decoder settings one at a time
while verifying the operation of the Reader (see Chapter 13).

Chapter Objectives

Helpful Hints
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A label usually contains human readable text and one or more bar
code symbols that appear within the Reader scan area on a package.
Each bar code symbol may have different characteristics such as
symbology, prefixes, lengths, or check characters.  The bar code
symbols must be oriented in the same direction if read by a single
scanner. 

Below is an example of a typical label.

PART NO. (P)

QUANTITY (Q)

SUPPLIER (V)

SERIAL (S)

27842

9106

By defining the expected content of a label, you can reduce the
possibility of a misread and increase the read rate.  AdaptaScan
software can store and exchange label setups between Readers,
allowing you to create a library of label configurations.

What is a Label?
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A label setup defines what labels the Reader is to scan.  A typical
label is defined below.

Model Number Manufacturing No.

Symbols Per Scan
Two Code 39 bar code symbols
are scanned followed by a single
UPC-A symbol.  Symbols per
Scan is set to Any.

Symbology
Two Code 39 bar code symbols are scanned followed by a single
UPC-A symbol. Code 39 labels do not use a check character and the
UPC-A label does not have any supplements.

Quiet Zone Ratio
Set to default of 7.

Negative Image
All symbols are positive images (black bars) so Negative Image is not
selected.

Specific Lengths
UPC-A symbols are always 12 characters so a length cannot be spe-
cified.  The Code 39 symbols are set to a specific length of  7.

Indentifier
Identifier is not required.

What is a Label Setup?
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The Bar Code Labels dialog defines what labels the Reader is to
decode.  Open this dialog by selecting either:

• Labels button on the main Project dialog.

• Label button on the Decoder dialog.

Bar Code Labels

Displays a list of defined bar code labels.

Select: To:

New Open the Bar Code Label dialog to create a new label defini-
tion.

Edit Open the Bar Code Label dialog for the highlighted label defini-
tion.

Cut Cut the highlighted label definition to the clipboard.

Paste Move the label definition from the clipboard to the Bar Code
Labels listing.  Select Paste multiple times to make copies of
the label definition.

Managing Bar Code Labels
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The Bar Code Label dialog specifies the symbols allowed on a bar
code label and other label parameters.  Open this dialog by selecting
the New or Edit  button on the Bar Code Label dialog.

Opens the
Symbologies Dialog

Label Name

Specifies a unique name (up to 250 alphanumeric characters
including spaces) for the label definition.  The name appears in the
Decoder dialog allowing you to assign the label to a Reader.

Symbols Per Scan

Specifies the number of bar code symbols the Reader must read in a
single scan (single left - right movement of the scan beam).

Select: To:

1 Read a single bar code symbol in each scan.

2 - 6 Read up to 6 bar code symbols within a single scan.

Any Read labels where the number (from 1 to 6) or location of bar
code symbols varies or is unknown.
The symbols within a label must be unique.  
Identical symbols on separate scans are seen as 
duplicates; the second symbol is ignored.

Defining a Bar Code Label
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Quiet Zone Ratio

Specifies the ratio of the clear space before the first bar and after the
last bar to the narrow element width.  Enter a value from 1 to 10, 7 is
the default.  Symbology standards require a quiet zone ratio of 10.
However, the default of 7 allows for compensation of noncompliant
symbols.

The Reader uses the quiet zone to determine if adequate clear space
precedes and follows the symbol.  Symbols without an adequate
quiet zone are ignored.

Clear
Space

Clear
Space

Quiet Zone Ratio = 10
Width Clear Space

Width 1st Bar

Negative Image

When selected, only negative images of bar code symbols are
decoded.  A negative image has white bars on a dark background.

Normal Code Negative Image

Symbols

Select: To:

New Open the Bar Code Label Symbol dialog to define a symbol.

Edit Open the Bar Code Label Symbol dialog for the highlighted
symbol definition.

Cut Cut the highlighted symbol definition to the clipboard.

Paste Move the symbol definition from the clipboard to the Bar Code
Label Symbol list.  Select Paste multiple times to make copies
of the symbol definition.
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The Used By dialog lists Readers using the same label setup.  Use
this dialog when making changes to a label setup and when you want
to view or access other Reader configurations using the same setup.

Currently Used By

Displays Reader configurations that use the same label setup.
Highlight the label setup you want to access and click the Goto
button.  A dialog opens for the highlighted Reader.

Viewing Readers with the
Same Bar Code Label Setup

☞ Or double-click on the 
highlighted label setup.
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The Bar Code Label Symbol dialog defines the symbols expected on
a bar code label.  Open the Bar Code Label Symbol dialog by: 

• Selecting the New button on the Bar Code Label dialog (creates a
new symbol definition).

• Selecting the Edit  button on the Bar Code Label dialog (opens
dialog for highlighted symbol definition).

Name

Specifies a unique name for the symbol definition.  The name
appears in the Symbols list of the Bar Code Label dialog, allowing
you to assign the symbol definition to the label setup.

Symbology

Specifies the symbology associated with the symbol name. The
options are: Codabar, Code 128, Code 39, Code 93, Discrete 2 of 5,
EAN-13, EAN-8, Interleaved 2 of 5, Matrix 2 of 5, Pharma Code,
UPC-A, UPC-E, and USPS 2 of 5.

Identifier

Optional data field in which you enter characters that identify the
symbol from other symbols on the same label.  The identifier is used
when a symbol has a unique prefix (P,Q,V,S, etc).  For an example
see page 6–2.

Note:  This field supports metacharacters.  Refer to Appendix C for
a description of the available metacharacters.  Make sure that the
characters you enter are not misinterpreted as a metacharacter string
or unintended operation may result.

Defining Symbols 
for a Bar Code Label

☞ Or double-click on a symbol 
name in the Symbols box to 
open the dialog.
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Include Identifier

When selected, the identifier is included as part of the symbol data.

Lengths

Optional data field that specifies the minimum and maximum
number of characters in the symbol.  Enter up to 3 specific lengths
for each symbol definition.  Symbols that do not have the specified
number of characters are ignored.

For: Guidelines are:

Code 39 The code length includes the check character but not the start
and stop characters.

Codabar Code length includes the check character and the start and
stop characters.

Code 128 The code length does not include the check characters or start
and stop characters.  Shift characters within the symbol are not
included in the length.  The Reader ignores Code 128 FNC2,
FNC3, and FNC4 characters regardless of the CODE 128
FNC1 setting.  FNC2, FNC3, FNC4 are also ignored by the
specific length check.

Code 93 The code length does not include the check characters or start
and stop characters.  Shift characters within the symbol are not
included in the length.

Discrete 2 of 5 The code length includes the check character but not the start
and stop characters.

I 2 of 5 The code length includes the check character but not the start
and stop characters.

Matrix 2 of 5 The code length includes the check character but not the start
and stop characters.

PharmaCode The length defines the number of characters in the decoded
symbol.  The maximum character length of a 12 bar Pharma-
code symbol is 5.

USPS 2 of 5 Does not have start, stop or check characters.  The length is
the number of data characters in the symbol.
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Open the Symbologies dialog by selecting the Symbologies button
on the Bar Code Label Dialog.  This dialog defines characteristics
specific to each symbology.

Symbology

List the available symbologies.  A check mark in front of the
symbology indicates that the symbology is used in the label
definition.

Select the Edit  button to open a dialog for a highlighted symbology.

Selecting Symbologies 
for a Bar Code Label

☞ Or double-click on a
symbology to open the
corresponding dialog.
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Code 39 and Codabar

Open the Code 39 or Codabar dialog by highlighting the symbology
in the Symbologies dialog and then selecting the Edit  button.

Check Character

Verify Verify the check character for each symbol that is read.  A sym-
bol is invalid if the calculated code does not match the decoded
check character.
Code 39 checksum is the modulus 43 sum of all character
values. Codabar checksum is the modulus 16 sum of all char-
acter values.

Verify & Strip Verify the check character on each symbol and then remove
the check character from the data.  The symbol is invalid if the
calculated code does not match the decoded check character.

None Check characters are not verified.

Discrete 2 of 5

Open the Discrete 2 of 5 dialog by highlighting Discrete 2 of 5 in the
Symbologies dialog and then selecting the Edit  button.

Guard Bars

Verifies the presence of guard bars. When selected, the guard bars
must be present to decode a symbol.  When not selected, the symbol
is decoded with or without guard bars.

☞ Or double-click on a 
symbology in the Symbologies 
box to open the dialog.

☞ Or double-click on a 
symbology in the Symbologies 
box to open the dialog.
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Interleaved 2 of 5

Open the Interleaved 2 of 5 dialog by highlighting Interleaved 2 of 5
in the Symbologies dialog and then selecting the Edit  button.

Check Character

Select: To:

None Handle all decoded characters as data.

Verify Verify the check character on each symbol that is read.  The
symbol is invalid if the calculated code (modulus 43 sum of all
character values) does not match the decoded check character.

Verify & Strip Verify the check character on each symbol and then remove
the check character from the data.  The symbol is invalid if the
calculated code does not match the decoded check character.

Guard Bars

Verifies the presence of guard bars. When selected, the guard bars
must be present to decode a symbol.  When not selected, the symbol
is decoded with or without guard bars.

Enable 2 Character Codes

Allows reading of Interleaved 2 of 5 symbols consisting of only 2
characters.  The Reader will ignore 2 character symbols unless this
box is selected.

Note:  Do not enable 2 character codes unless you are reading 2
character codes.  Otherwise, a partial scan of symbols could result in
a valid short read.

☞ Or double-click on a 
symbology in the Symbologies 
box to open the dialog.
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UPC-A, UPC-E, EAN-8, EAN-13

Open the UPC and EAN dialogs by highlighting the symbology in
the Symbologies dialog and then selecting the Edit  button.

Supplements

Select: To:

2 Enable decoding of 2 character supplements.  Both the primary
code and supplement are required for a valid read.

5 Enable decoding of 5 character supplements. Both the primary
code and supplement are required for a valid read.

2 and 5 Enable decoding of both 2 and 5 character supplements. Both
the primary code and supplement are required for a valid read.

Auto Enable the Reader to decode labels with or without supple-
ments.  Just the primary code is required for a valid read.

Expand (UPC-E Codes Only)

When selected, bar code data is transmitted in a 12 digit (expanded)
format.  If Expand is not selected, data is sent in a 6 digit
(compressed) format.

☞ Or double-click on a 
symbology in the Symbologies 
box to open the dialog.
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Matrix 2 of 5 

When editing the Matrix 2 of 5 symbology, the following options are
available:

Check Character

Select: To:

None Handle all decoded characters as data.

Verify Verify the check character on each symbol that is read.  The
symbol is invalid if the calculated checksum (see below) does
not match the decoded check character.

Verify & Strip Verify the check character on each symbol and then remove
the check character from the data.  The symbol is invalid if the
calculated code does not match the decoded check character.

Guard Bars

Verifies the presence of guard bars. When selected, the guard bars
must be present to decode a symbol.  When not selected, the symbol
is decoded with or without guard bars.

Matrix 2 of 5 Check Character

The AdaptaScan performs a modulus 10 check of a Matrix 2 of 5
code as follows:

1.  Start and Stop codes are not included in the checksum.
2.  Sum of even position digits is multiplied (weighted) by 3.
3.  Sum of odd position digits is multiplied (weighted) by 1.
4.  Odd and even weighted results are added together.
5.  Divide the sum of the odd and even weighted results by 10.
6.  Subtract the remainder of the division from 10 to obtain the checksum.

For example, the following code is decoded, the most significant
digit (digit #1) is to the left.  The least significant digit is to the right
and is an even position digit.

8 6 1 3 2 5 1 8
Sum of 3 (sum even digits) + (sum odd digits) = 3 (6 + 3 + 5 + 8) + (8 + 1 + 2 + 1) = 78

Code =

Sum/10 = 78/10 = 7 with Remainder = 8
Checksum = 10 - Remainder = 10 - 8 = 2
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Pharma Code

Open the Pharma Code dialog by highlighting Pharma Code in the
Symbologies dialog and then selecting the Edit  button.

Min # of Bars

Specifies the minimum number of bars required in a valid Pharma
Code symbol.  The Reader only decodes symbols with an equal or
greater number of bars than the minimum bar setting.  Valid values
are 3 to 12.  The default is 5.

Decode Direction

The Reader uses the decode direction to determine the least
significant bar within a symbol.

Select: To:

Forward Decode symbols in a left to right direction.

Reverse Decode symbols in a right to left direction.

The decode direction determines the value of the decoded symbol:

Decode Direction
Value = 94

Least 
Significant 
Bar

Most 
Significant 
Bar

Decode Direction
Value = 125

Least 
Significant 
Bar

Most 
Significant 
Bar

☞ Or double-click on a 
symbology in the Symbologies 
box to open the dialog.
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Space Tolerance

The maximum allowed tolerance (percent difference in width)
between the narrowest and widest space elements.

Enter: To:

Tolerance Specify the percent difference (in width) between the narrowest
and widest space elements.  Enter a value between 5 and 40.
The default of 15 is recommended for most applications.

Space tolerance is calculated as follows;

Widest Space – Narrowest Space

Widest Space + Narrowest Space

3

x 100 = % Space Tolerance

Min Wide to Narrow Bar Ratio

Specifies the minimum ratio of the widest bar to the narrowest bar
within a symbol.  Select: No Check, 2, or 3.

Bar Tolerance

Note:  The maximum number of bars allowed in a symbol is 12.

The maximum tolerance (percent difference in width) between two
wide bars of a symbol or between two narrow bars of a symbol.
Enter a value between 5 and 40.  The default of 15 (15%) is
recommended for most applications.

Bar tolerances are calculated as follows:

Widest Wide Bar – Narrowest Wide Bar

Widest Wide Bar + Narrowest Wide Bar

3

x 100 = % Wide Bar Tolerance

Widest Narrow Bar – Narrowest Narrow Bar

Widest Narrow Bar + Narrowest Narrow Bar

3

x 100 = % Narrow Bar Tolerance
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USPS 2 of 5

Open the USPS 2 of 5 dialog by highlighting USPS 2 of 5 in the
Symbologies dialog and then selecting the Edit  button.

Decode Direction

The Reader uses the decode direction to determine the least
significant bar within a symbol.

Select: To:

Forward Decode symbols in a left to right direction.

Reverse Decode symbols in a right to left direction.

The decode direction determines the value of the decoded symbol:

Decode Direction = Forward
Value = 15084

Decode Direction = Reverse
Value = 53041

Least 
Significant 
Bar

Most 
Significant 
Bar

Least 
Significant 
Bar

Most 
Significant 
Bar

Space Tolerance

The maximum allowed tolerance (percent difference in width)
between the narrowest and widest space elements.  Enter a value
between 5 and 40.  The default of 20 (20%) is recommended for
most applications.

Space tolerance is calculated as follows;

Widest Space – Narrowest Space

Widest Space + Narrowest Space

3

x 100 = % Space Tolerance

☞ Or double-click on a 
symbology in the Symbologies 
box to open the dialog.
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This chapter configures the operation of the Reader’s decoder.

Section Page

Helpful Hints 7–1

Decoding Functions 7–1

Valid Symbologies 7–2

When Decoding Occurs 7–3

Capture Count 7–5

Setting Decode Parameters 7–6

Configuring the Performance Indicator 7–8

Viewing Readers with the Same Trigger Source 7–10

When configuring the Reader’s decode functions:

• Enable only the bar code symbologies the Reader will scan to
increase decode speed and reduce misreads.

• During initial setup, use the Self-Triggered decode option and
specify an Inter-Symbol No-Read Count.  The Reader will
continuously attempt to decode data.

• To prevent misreads, trigger decoding only when a bar code label
is within the scan area of the Reader.

The Decoder dialogs define:

• When the Reader decodes bar code symbols from the scanner.

• What bar code symbologies are decoded.

• Minimum performance level before an alarm occurs.

Chapter Objectives

Helpful Hints

Decoding Functions
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The Reader can be configured to decode the following symbologies:

Interleaved 2 of 5

EAN-8

Code 39

Code 128

EAN-13

UPC-A UPC-E

Pharma Code

Codabar Code 93

Discrete 2 of 5

USPS 2 of 5

Each of the symbologies has properties you can set up such as guard
bars, check characters and supplements.

Guard Bar

Supplemental Digits

Guard Bar

Valid Symbologies
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The Decoder dialog settings determine when the Reader starts and
stops decoding.  The trigger source may be from or on the Reader
you are configuring or another Reader on the same network (when
using DeviceNet peer-to-peer communications).  You can use the
same package trigger for multiple Readers on a DeviceNet
peer-to-peer network or you can “chain triggers” where one Reader
is a trigger source for another Reader.  Once triggered, the Reader
attempts to decode symbols until a trigger off is received.

Trigger inputs include: Self-Triggered, Package Detect, Discrete
Input, Timer, ASCII Command, Input Timer, or DeviceNet Inputs.
You can also select bracketed indirect trigger sources defined for
other functions such as [Match Table], [Package], [Message].

Note:  [Match Table], [Package] or [Message] do not appear as
options unless a trigger has been defined for the match table,
package or message functions.

Self-Triggered Source

The Reader continuously attempts to decode data.

Package Detect Trigger Source

The Reader decodes data only after receiving a trigger from the
package detect sensor attached to the Reader.

Photo-Electric
Package Detector

When Decoding Occurs
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Discrete Input Trigger Source

The Reader decodes data only after receiving a trigger from a
discrete input (located in the wiring base).

Wiring Base

Reader

I/O Modules

Timer Trigger Source

The Reader decodes data only when the internal timer is On.  The
timer can be configured On or Off for independent periods of time.

Internal Timer

ASCII Command Trigger Source

Data is only decoded after an ASCII Trigger On command is
received.  The Reader decodes data until a Trigger Off command is
received, a valid package is decoded or the timer times out.

ASCII Host Command
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Input Timer

Timer which is triggered by another source.  Typically used to
coordinate multiple Readers scanning the same package.

DeviceNet Input

Up to 7 discrete DeviceNet inputs trigger decoding.  Refer to
Configuring DeviceNet Inputs on page 9–15.

[Package]

The same trigger configured for package is also used to trigger
decoding.  See page 11–13.

[Message]

The same trigger configured for messages is also used to trigger
decoding.  See page 10–5.

[Match Table]

The same trigger configured for match table is also used to trigger
decoding.  See page 11–8.

[Decoder]

The same trigger configured for decoding on another Reader is also
used to trigger decoding on the current Reader.

The capture count specifies the number of consecutive identical valid
decodes before a valid read occurs.

If Capture Count  is 3 or less, Scan is Valid

If Capture Count  is 4 or more Scan is not Valid
Scan 2

Scan 3

Scan 1

ABC

ABC

ABC

Use higher capture counts to reduce misreads.  Symbologies that are
not self-checking (do not use start and stop characters or check
characters) are more susceptible to misreads.

Setting the capture count too high may result in excessive no-reads,
particularly when the number of scans crossing the label during a
trigger period is low (5-10).  Set the capture count to a value no
greater than half the number of scans crossing the label during a
single trigger period.

Capture Count
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The Decoder dialog configures decoding functions and is opened by
selecting the Decoder button on the main Project window.

Opens Used By Dialo

Opens More Dialog

Capture Count

Specifies the number of identical valid scans that must be decoded
for a valid read.  Enter a value from 1 to 8.  Use the default value of
2 for most applications.

Bar Code Label 

Specifies the label setup the Reader is to decode. If none are defined,
you can select the Label button to open the Labels dialog.

Triggered By 

Specifies the trigger source to initiate decoding.  The trigger is
defined by the Reader name and type of trigger input.

Self-Triggered

When selected, decoding occurs continuously.  Use the Inter-Symbol
No-Read Count (see page 7–9) to prevent multiple decodes of the
same symbol.

Note:  When using Self-Triggered, increase the capture count to
greater than 2 (we recommend a value of 5 or 6).

Setting Decode Parameters
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Device

Selects the device that is the source of the trigger.  The trigger may
be from the current Reader or any other Reader on the same network.

Input
Select: To Trigger Decoding:

Package Detect Using the package detect input.

Timer Using the Reader’s internal timer.

ASCII 
Command

Using an ASCII command sent from a host.

Discrete I/O Using a Reader input module.

Input Timer Using an input timer.

DeviceNet 
Input

Using one of the 7 DeviceNet inputs.

[Package] Using the trigger defined for packages.

[Message] Using the trigger defined for messages.

[Match Table] Using the trigger defined for the match table.

[Decoder] Using the same trigger assigned to the Decoder of another
Reader.
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The Decoder-More dialog configures the operation of the
performance indicator and inter-symbol timer.  Open this dialog by
selecting the More button on the Decoder dialog.

Performance Indicator Output

Configures the output indicator to assert when the margin or number
of decoded scans drops below a setpoint.

Select: To:

Low Limit Specify the setpoint at which a discrete output signals low per-
formance.  Enter a value between 0 – 99%, which represents
either margin or a count of the valid reads during a trigger peri-
od.

Disable Enable/Disable the low performance output indicator.  Low
performance output is disabled when this button is selected.

Count Performance indicator triggered when the number of decodes
per trigger period drops below the Low Limit setting. The num-
ber of decodes per trigger is updated at the end of the trigger.

Margin Performance indicator is triggered when the decode margin
drops below the Low Limit setting.  See page 3–8 for a descrip-
tion of margin.

Device Specify the Reader to receive the output indication when per-
formance falls below the low limit.

Output Specify the output module to energize on the Reader when
performance falls below the low limit.

Configuring the
Performance Indicator
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Inter-Symbol No-Read Count

Specifies the minimum number of no-reads that must occur between
decoded symbols before the next symbol can be decoded.  This
prevents multiple decodes of the same symbol while allowing
identical symbols to be decoded as long as a definite space (no–read)
occurs between them:

1
2

3
4

5
6

7

1
2

3
4

5
6

7

Inter-Symbol No-Read Count = 3

Direction of Travel

1
2

3
4

5
6

7

1st Symbol
Scanned

Last Symbol
Scanned

2nd Symbol
Scanned
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The Used By dialog lists other Readers that use the same trigger
source.  Use this dialog when making changes to a configuration and
you want to view or change other configurations assigned to the
same trigger source.

Currently Used By

Displays the Reader configurations that use the decoder trigger as a
trigger source.  Highlight the configuration you want to access and
click the Goto button.

Viewing Readers with the
Same Trigger Source
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This chapter shows how to configure the Reader’s communications
ports.

Section Page

Communication Ports 8–2

Protocols 8–2

Configuring DeviceNet Parameters 8–3

Configuring the Serial Port 8–5

Configuring Terminal Communications 8–8

Configuring DF1 Communications 8–10

Configuring DH-485 Communications 8–11

Used By Dialog 8–12

   Chapter Objectives



8–2

Publication 2755-838

Terminal block connections in the wiring base provide all power,
I/O, and communication links to a Reader.  The RS-422/RS-485 or
RS-232 port may be used at the same time as the DeviceNet link.

DeviceNet

Supports multiple Readers and allows them to communicate with
other devices on the network.  The DeviceNet cable consist of four
wires (2 power and 2 communications) and a shield connected to the
Reader wiring base.

RS-422 / RS-485 Port

An RS-422 / RS-485 port allows multidrop communications with a
single device or network such as a SLC 500 DH-485 network.

RS-232 Port

Provides point-to-point communications with a device having an
RS-232 port such as a PLC-5 Channel 0 port configured for RS-232.

Note:  The Configuration Port Connector on the Reader is used to
download configurations, not the RS-232 connection.

The RS-485/RS-422 and RS-232 serial ports support these protocols.

Terminal

Use dumb terminal (ASCII) protocol to communicate with a variety
of devices.  This is the least secure of the protocols.

DF1

Use DF1 protocol to communicate with devices such as a PLC-5 that
also supports DF1 protocol.  DF1 protocol provides error checking
capabilities.

DH-485

Use DH485 protocol to communicate with DH485 devices such as
an SLC 500 DH485 network or point-to-point link.

Communication Ports

Protocols
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Two dialogs define DeviceNet parameters, one defines the baud rate
of the project, the other defines a Reader address within the project.

Project Dialog

The Project dialog defines the baud rate for all Readers on the same
DeviceNet network.  The project name and description fields are
defined on page 2–17.  The Project dialog opens whenever you open
a new project or when selecting Edit  from the Project menu.

DeviceNet Baud Rate

Select a rate for all Readers defined within the project.

Baud Rate: Supports maximum cable length of:

125 Kbps 1600 feet (500 meters)

250 Kbps 600 feet (200 meters)

500 Kbps 300 feet (100 meters)

Configuring 
DeviceNet Parameters
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Device Dialog

The Device dialog sets the Reader DeviceNet address.  Open the
Device dialog by selecting the Device button on the Project dialog or
by double-clicking a Reader name in the project window.

If the Device is online but not in the project 
database, the following dialog is displayed:

If the Device is online and in the current project 
database, the following dialog is displayed:

Each reader must be assigned a unique DeviceNet address.  Shipped
from the factory, the Reader is assigned a default node address of 63.
Assign each Reader an address between 0 and 63.

The DeviceNet Buffer dialog defines the warning provided when the
message buffer reaches 75% capacity.  If the buffer capacity is
exceeded, message data will be lost.  Access the buffer
configuration dialog by selecting the More button on the Device
Dialog.

When the warning buffer is enabled, you must specify both the
Reader and the output that will be activated.

DeviceNet provides an adjustable background heartbeat that
indicates to a device receiving data that the AdaptaScan is online and
still active.  Set the heartbeat pulse period from 0 to 65535
milliseconds (3,000 is the default).
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The Serial Port dialog configures the Reader’s serial port.  Open this
dialog by selecting the Serial Port button on the Project dialog.

Protocol

Specifies the communication protocol for the Reader.

Select: To:

Terminal Communicate with devices that support terminal communica-
tions using ASCII protocol.

DF1 Communicate with a device supporting DF1 protocol such as a
PLC-5.

DH-485 Communicate with a DH-485 device using a point-to-point or
network connection (such as SLC 500).

Select the Edit button to edit the selected protocol.

Configuring the Serial Port
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Scanner Protocol

For most applications this check box should be cleared.  Select the
Scanner Protocol check box only when you need to:

• Configure a Reader using a computer connected to a serial port in
the Reader’s wiring base.

• Use Allen-Bradley APM (Application Protocol Messages)
protocol to configure a Reader.  APM protocol is often used by
system integrators who want to design custom applications
without using the AdaptaScan Configuration software.  Contact
Allen-Bradley for additional information on APM protocol.

Baud Rate

Specifies the baud rate of the serial port.  Set the baud rate to match
the device you are communicating with.

Maximum Length

Specifies the maximum length of data (in bytes) that is transmitted or
received.  Specify a maximum length when the device the Reader is
communicating with has a limited buffer for receiving messages.
The Reader will truncate messages sent or received that are greater
than the specified length.  A length of 0 disables length checks.

Parity

Specifies the parity used by the Reader when sending messages.
Select None, Even or Odd.  None is the default for Terminal and
DF1 protocols.  Parity is automatically set to Even for DH-485
protocol.

Data Bits

Specifies the number of data bits sent with each message from the
Reader.  The default is 8.  Data bits only applies to terminal protocol.
For DH-485 and DF1 protocols, the data bits are automatically set 
to 8.

Stop Bits

Specifies the number of stop bits sent with messages from the
Reader.  The default is 1 for Terminal and DF1 protocols.  Stop bits
is automatically set to 1 for DH-485 protocol.
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Message Buffer

Specifies the number of messages held in the message buffer and the
limit at which a warning occurs if the buffer size is exceeded.  Use
the message buffer when the host device cannot handle high data
rates from the Reader.

Note:  Do not set the buffer size >1 when data sent to a host device
must be coordinated with the I/O on a Reader.

Select To

Enable Warning Enable the buffer full warning.

Warning At Specify the warning limit for the buffer (default is 2).  When the
limit is met or exceeded, a warning is provided.

Buffer Size Specify the maximum number of messages the message buffer
can store (default is 5).  Buffer is always active whether or not
warning is enabled / disabled.

Device Select the Reader that will provide the buffer 
warning.

Output Select the output to energize when the buffer limit is reached.

Connection

Select the communications port that can connect to the host.  Select
RS-232, RS-422 or RS-485.

Enable Pass-Through to DeviceNet

Allows data from the serial port to pass through to a DeviceNet
network.  Page 10–15 shows an example of how to use this feature.
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The Terminal dialog configures parameters of the Terminal protocol.
Open this dialog by selecting Terminal protocol on the Serial Port
dialog and then selecting the Edit button.

Flow Control

Specifies the type of handshaking between the Reader and the host
device.

Select For

XON/XOFF Software flow control.

CTS/RTS Hardware flow control in which the sending device transmits a
Request to Send and the receiving device replies with a Clear
to Send before transmitting the data.

None No flow control.

Header

Specifies a 1 to 32 ASCII character string to precede each message.
Only  messages with the specified header are accepted and sent. The
default is no header.   See Appendix A for an ASCII table and
instructions on how to enter non–printable characters.

Trailer

Specifies a 1 to 32 ASCII character string that is appended to each
message.  Only messages with the specified trailer are accepted and
sent.  The default is no trailer.

Note:  You must either provide a trailer or specify a Maximum
Length (see page 8–6).  The trailer or message length are used to
indicate the end of a message.

See Appendix A for an ASCII table and instructions on how to enter
non–printable characters.

Configuring
Terminal Communications
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Special Protocol

Specifies a custom ACK/NAK protocol to communicate with a host.

The ACK character is sent by the host to acknowledge the receipt of
a message.  The Reader holds the last transmitted message until
receiving an ACK.  The NAK character is sent by the host when a
message is not received, prompting the decoder to resend the
message.

Select To

Enable Use special ACK/NAK protocol.

ACK Enter the decimal equivalent value of an ASCII character from
0 - 255.  See Appendix A.

NAK Enter the decimal equivalent value of an ASCII character from
0 - 255.  See Appendix A.

Hex Conversion

When selected, messages sent to a host are converted to a
hexadecimal format.  Use Hex conversion when sending
non-printable data in a printable format.  This option is usually only
used when using APM protocol to configure a Reader (see Scanner
Protocol on page 8–6).  The default is disabled.

Transmission Check

Specifies the type of transmission check bytes sent with each
message.  Use transmission checks to verify that messages have been
correctly received by the Reader or host device.  Appendix D
describes the transmission checks and provides an example.

Select To

None Perform no transmission check.

LRC Enable Longitudinal Redundancy Check characters.

Checksum LSB Enable 16 bit checksum where the least significant byte is
transmitted first.

Checksum MSB Enable 16 bit checksum where the most significant byte is
transmitted first.
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The DF1 dialog configures parameters of DF1 protocol.  Open this
dialog by selecting DF1 protocol on the Serial Port dialog and then
selecting the Edit  button.

Retries

Specifies the number of retries when sending a message.  Select a
value between 0 and 20.  The default is 10.  A value of 0 specifies an
unlimited number of retries.

Timeout

Specifies the number of milliseconds to wait before a
communication error is detected and a message retry occurs.  The
default is 3000 milliseconds (3 seconds).  A value of 0 indicates no
timeout.

Verification

Specifies the type of verification used to check the validity of a
message.

Select To

BCC Select Block Check Character verification of messages.

CRC Select Cyclic Redundancy Check verification of messages.

Configuring DF1
Communications
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The DH-485 dialog configures parameters of DH485 protocol.  Open
this dialog by selecting DH485 protocol on the Serial Port dialog and
then selecting the Edit  button.

Node

Specifies a unique node address of the Reader on the DH485
network.  If you are communicating point-to point, you must still
provide a node address different than the host device.  The DH-485
node address may be different than the DeviceNet address assigned
for downloading configurations.

Important: When configuring an SLC DH-485 network with
AdaptaScan Readers, the nodes must be in sequential order.  The
SLC must be node 1 and the Readers must follow (node 2, node 3,
...)  Do not allow gaps between node addresses.

Maximum Node (Master Mode only)

Specifies the highest node number used by a device on the DH485
network.  A low maximum node number improves network
performance since nodes above the maximum node are not scanned.

Master/Slave

Specifies whether the Reader is operating as a master or slave device
on the DH485 network.  The default is slave.  As a slave, the Reader
cannot initiate messages but only respond to requests from a host.
Master mode is only for communications with an SLC.

PCCC Enabled

Enables or disables the PCCC application layer.  You must enable
PCCC when you are communicating with an SLC 500 (master or
slave) using DH485 protocol.

Configuring DH485
Communications
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Destination

Specify the destination node and address to receive the bar code data
when the Reader is selected as a Master.

Select: To:

Node Specify the node address of the device that is to receive the
bar code data.  Select a value 0 to 31.

N9:Offset Specify the processor interface file offset address to receive the
bar code message.  Select an address in the range of 0 to
32,765.  The default is 100.

The Used By dialog lists other Readers that use the same serial port
configuration.  Use this dialog when you make changes to a
configuration and you want to make changes to other Readers using
the same configuration.

Currently Used By

Displays the Reader configurations that use the same serial port
setup.  Highlight the configuration you want to access and click the
Goto button.

Viewing Readers 
with the Same Serial Port
Configuration

☞ Or double-click a 
configuration and click the 
Goto button.
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This chapter defines the operation of the Reader’s discrete I/O.

Section Page

Helpful Hints 9–1

Types of Outputs 9–2

Types of Inputs 9–3

Configuring Inputs and Outputs 9–5

Configuring Discrete Inputs & the Package Detect 9–6

Configuring Discrete Outputs 9–8

Configuring the Timer 9–9

Configuring Input Timers 1 and 2 9–10

Configuring an ASCII Trigger 9–12

DeviceNet I/O 9–13

Configuring DeviceNet Inputs 9–15

Configuring DeviceNet Outputs 9–16

When setting up discrete inputs or outputs:

• If possible, use the package detect input not a discrete input for a
package detector.  The package detect input is used with a current
sinking or hard contact detector (usually a photo-electric device).

• Input and output devices have default names which can be
changed. If you change the I/O name, make sure the new name
describes both the type of input and the output number (1 or 2) or
the input number (1 or 2).

Chapter Objectives

Helpful Hints
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Each Reader can accept two I/O modules.  When an output module
is installed, it can be controlled by the Reader configuration or any
other Reader on the same network.

Discrete Output

You can install two discrete output modules in the Reader’s wiring
base.  These modules are available with a variety of voltage and
current ratings (refer to the AdaptaScan Bar Code Reader user
manual).  Assign discrete outputs either a normally open or normally
closed state (to determine when output is energized).

Wiring Base

Reader
Positions for 
2 I/O Modules

Each output can be controlled by any Reader on the same network.

DeviceNet Output

The Reader DeviceNet communications support up to 15 discrete
outputs.  Use these outputs as inputs for other DeviceNet devices.
Refer to page 9–13 for descriptions of DeviceNet I/O.

Types of Outputs
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A Reader can access 6 types of inputs: a discrete input, DeviceNet
input, package detect, ASCII command, timer, input timer.  Use
these inputs as a trigger for decoding, scanning, messages and
packages.

Discrete Input

You can install two discrete input modules in the Reader’s wiring
base.  These modules are available with a variety of voltage and
current ratings (refer to the AdaptaScan user manual).  You can
configure discrete inputs to be ON when the input is either a high or
low state.  In addition, inputs can be assigned a delay, debounce
filter, and have a cyclic operation when ON.  An input can be used
by any Reader on the same network.

Wiring Base

Positions for 
2 I/O Modules

DeviceNet Input

The Reader DeviceNet communications support up to 7 discrete
inputs.  Use these inputs as trigger sources for functions such as
decoding, message trigger, auto-load trigger, etc.   Refer to page
9–13 for descriptions of DeviceNet I/O.

Types of Inputs
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Timer

Each Reader contains an internal timer.  Use a timer as a trigger for
decoding, scanning, messages or packages.  You can configure a
timer for variable on and off times.

Trigger On

Trigger Off

Trigger On

Each timer output can be used as a trigger source by any Reader on
the same DeviceNet peer-to-peer network.

Package Detect

The package detect input functions like a discrete input (same dialog
configures both) however, there is a separate terminal block
connector for the package detector.

Package
Detector Package Detect 

Terminal Block

ASCII Command Input

An ASCII command from a host device that the Reader interprets as
a trigger input.  Specify any ASCII string to turn the trigger On/Off.

Begin Trigger

End Trigger

If your ASCII command messages do not use a trailer, you must
specify a message size (see Chapter 9).  The trailer or message size
allows the Reader to separate ASCII commands from other data.

Timer Input

Functions like the timer described above but is triggered by another
source.
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From the Input & Output dialog you select and configure the
operation of the Reader’s input and output devices.  Open this dialog
by selecting the Input/Output  button on the main Project dialog.

Inputs and Outputs

Displays a listing of the inputs and outputs available to the Reader.
Items that appear with a check mark are in use.

Select: To:

Package Detect Define the package detect input.

Discrete Input/Output 1 Define the operation of the I/O module installed in position # 1
of the wiring base.

Discrete Input/Output 2 Define the operation of the I/O module installed in position # 2
of the wiring base.

Timer Define the operation of the Reader’s internal timer.

ASCII Command 
Input 1 or 2

Define the ASCII strings that a host can send as ASCII com-
mand 1 or 2.  Each command contains both a trigger on and
trigger off ASCII string.

Input Timer 1 or 2 Define the input timers.  Input timers function like a timer but
are triggered from another source.

DeviceNet Input 
1 to 7

Define the discrete DeviceNet inputs available when communi-
cating with other devices through a DeviceNet scanner module.

DeviceNet Output 
1 to 15

Define the discrete DeviceNet outputs available when commu-
nicating with other devices through a DeviceNet scanner mod-
ule.

Select the Edit  button to open the dialog corresponding to the
highlighted input or output.

Used By

Opens the Used By dialog for the highlighted input or output.  The
Used By dialog displays other Reader configurations using the same
input or output.

Use As

Specifies whether a discrete input or output module is going to
occupy the position in the wiring base.

Selecting Inputs and Outputs

☞ Or double-click an input or 
output in the Inputs & Outputs 
dialog to open the 
corresponding dialog.
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The Discrete Input dialog configures the operation of the Reader’s
input module(s) or package detect input.  Open this dialog by
selecting an input from the list on the Input & Output dialog and
selecting the Edit  button.

Or double-click the input to open the dialog.

Input Name

Specifies a name for the input.  If you enter a new name, make sure
the name properly identifies whether the input is a discrete input or
package detect.  Also, if the dialog is defining a discrete input,
provide some indication for its position in the wiring base (#1 or #2).

ON When Input Is

Specifies whether the input is On when the signal to the input is high
or low.

Select: To:

High Turn the input ON when the input module or package
detect contacts are closed (input signal present).

Low Turn the input ON when the input module or package
detect contacts are open (input signal not present).

Debounce Filter

When selected, adds a 15 millisecond debounce period for the input
contacts.  Select the debounce filter when connecting an input
(discrete or package) to hard contacts.  Input signals less than 15
milliseconds are ignored with the debounce filter on.

Configuring Discrete Inputs
and the Package Detect
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Timing

Sets the signal duration and cycling after an input is detected.  Time
is specified in milliseconds (0 to 32,767).

Select: To:

On & Off Delay Specify a delay that occurs when an input signal changes
state.  After an input changes state, the Reader maintains the
current state for the On & Off delay period before recognizing
the new state.

Minimum 
On Time

Specify the minimum amount of time that an input remains
active.  If an input is on for a shorter duration than the time
entered, the input duration is lengthened.  Enter a value (0 to
32,767).

Maximum  
On Time

Specify the maximum amount of time that an input remains
active.  If an input is on for a longer duration than the time en-
tered, the input duration is shortened.  Enter a value (0 to
32,767).

Cyclic Operation

Turns the input on and off for set periods while the input is active.

Select: To:

Enable Enable or disable cyclic operation.

On Time Specify the amount of time in milliseconds that the input is on
during a cycle.  Enter 0 to 32,767.

Off Time Specify the amount of time in milliseconds that the input is off
during a cycle.  Enter a value from 0 to 32,767.

Limits

Specifies minimum and maximum on times for the package detect or
discrete input.

Select: To:

Min Enter the minimum amount of time (in milliseconds) that the
input is on.

Max Enter the maximum amount of time (in milliseconds) that the
input is on.
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The Discrete Output dialog configures the operation of the Reader’s
output module(s).  Open this dialog by selecting an output from the
list on the Input & Output dialog and then selecting the Edit  button. 

Output Name

Specifies a unique name for the output.  Enter a name that properly
identifies the output as discrete output 1 or 2 (position in wiring
base).

Output State

Specifies the inactive (untriggered state) of the output module
contacts.

Select: To Specify:

Normally Open The module output contacts open in the inactive (untriggered)
state.

Normally Closed The module output contacts close in the inactive (untriggered)
state.

On Time

Specifies the length of time the output remains active after triggered.
Enter a value in the range of 0 to 32,767 milliseconds (0 to 32.767
seconds).  A value of 0 indicates no timing, the output on time tracks
the input trigger.

Configuring Discrete Outputs

☞ Or double-click on an output
to open the dialog.
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The Timer dialog configures the operation of the Reader’s internal
timer.  Open this dialog by selecting Timer from the list on the Input
& Output dialog and then clicking the Edit  button.

Timer Name

Specifies a unique name for the timer.  This name will appear in lists
where a timer trigger can be assigned.

Cyclic Timer

Specifies the length of time that the timer remains on before cycling
off.

Select: To:

On Time Enter a value for the length of time the timer remains on before
cycling off.  Enter a value between 0 and 32767 milliseconds (0
to 32.767 seconds).

Off Time Enter a value for the length of time the timer remains off before
cycling on.  Enter a value between 0 and 32767 milliseconds (0
to 32.767 seconds).

Configuring the Timer

☞ Or double-click on Timer
to open the dialog.
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The Input Timer 1 and 2 function like the Package Detect with an
additional timer except they are triggered by another source.  Open
this dialog by selecting Input Timer 1 or 2 from the list on the Input
& Output dialog and clicking the Edit button.

Timer Name

Specifies a unique name for the timer.  This name appears in lists
where an input timer trigger can be assigned.

Triggered By

Specifies the trigger source that will initiate the input timer.  The
trigger is defined by the Reader name and input name.

Device

Specifies the device that is the source of the trigger.  The trigger may
be from the current Reader or any other Reader on the same network.

Input

The following selections are available as trigger input options.

Select: To:

Timer Use the internal Reader timer as the trigger source.

ASCII 
Command

Use an ASCII command input 1 or 2 as the trigger source.

Input Timer Use Input Timer 1 or 2 on another Reader as the trigger
source.

DeviceNet 
Input

Use a DeviceNet input as the trigger source.  See page 9–13.

Package Detect Use an external package detect as the trigger source.

[Decoder] Use the decode trigger as the trigger source.

[Match Table] Use the match table trigger as the trigger source.

[Package] Use the package trigger as the trigger source.

[Message] Use the message trigger as the trigger source.

Configuring the
Input Timers 1 and 2

☞ Or double-click on an
Input Timer to open the dialog.
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Timing

Specifies the operation of the Input Timer.

Delay

Specifies delays between the trigger input and the turning on and off
of the input timer.

Select: To:

On Enter the delay (in milliseconds) between the trigger input and
when the input timer turns on.

Off Enter the delay (in milliseconds) between when the trigger
input turns off and when the input timer turns off.

Limits

Specifies minimum and maximum on times for the input timer.

Select: To:

Minimum Enter the minimum amount of time (in milliseconds) that the
input timer can be on.

Maximum Enter the maximum amount of time (in milliseconds) that the
input timer can be on.

Cyclic Operation

Specifies that the input timer turns on and off for set periods after
being triggered.  Cyclic operation only occurs while the input trigger
is active.

Select: To:

Enable Enable cyclic operation.  When not selected, the timer remains
on.

On Time Enter the period of time (in milliseconds) that the input timer
remains on before turning off.

Off Time Enter the period of time (in milliseconds) that the input timer
remains off before turning on.
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The ASCII Command Input dialog configures ASCII commands that
the Reader will interpret as trigger on and trigger off commands.
Open this dialog by selecting ASCII Command 1 or 2 from the list
on the Input & Output dialog and clicking the Edit  button.

ASCII Command Name

Specifies a unique name for the trigger commands.  This name
appears in lists where an ASCII command trigger can be assigned.

Use Port On

Assigns the ASCII commands to a specific Reader.  The ASCII
trigger commands can only be assigned to a single Reader.

ASCII Command

Specifies the ASCII strings that the Reader interprets as a trigger on
or trigger off command.

Select: To:

Turn On ➀ Enter the ASCII string that the Reader will interpret as a trigger
on command.

Turn Off ➀ Enter the ASCII string that the Reader will interpret as a trigger
off command.

On Time Enter a value for the length of time the trigger remains on if a
trigger off command is not received.  Enter a value between 0
and 32767 milliseconds (0 to 32.767 seconds).  A value of 0
disables the timer.

➀ The message header and trailer or message size allow the Reader to separate
ASCII commands from other data.

Configuring an ASCII Trigger

☞ Or double-click on ASCII
Command to open the dialog.
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DeviceNet Peer-to-Peer Communications

Peer-to-peer communications are supported between Readers.  
You can easily transfer data, inputs, outputs, triggers and other data
between Readers by selecting the other Readers from the
configuration dialogs.  However, DeviceNet peer-to-peer
communication is only between Readers.  The Reader does not
support peer-to-peer communication with other types of DeviceNet
devices.  To communicate with other DeviceNet devices, you must
use DeviceNet master-slave communications.

Important:   The maximum number of Readers that can be
connected on DeviceNet peer-to-peer network is 32.

Each DeviceNet network must be all peer-to-peer or all master-slave
communications.  You cannot mix peer-to-peer and master/slave
communications on the same network.  Do not use AdaptaScan
DH-485 master-slave mode simultaneously with DeviceNet
communications (peer-to-peer or master-slave).

DeviceNet Master-Slave Communications

Connect the AdaptaScan Reader to other DeviceNet devices through
either a PLC (Catalog No. 1771-SDN) or SLC (Catalog No.
1747-SDN) DeviceNet scanner.  The AdaptaScan DeviceNet slave
supports up to 7 discrete inputs, 15 discrete outputs, and bar code
messages.  The AdaptaScan operates as a slave device to the
DeviceNet scanner.

Reader Reader
Other

PLC-5 with 1771-SDN (DeviceNet Scanner)

DeviceNet Devices

Note: DeviceNet Input #8 and Output #16 control the transmission
of bar code messages using DeviceNet master-slave.  Refer to
DeviceNet Messages in Chapter 10.

Note: The maximum number of readers that can be connected on an
AdaptaScan only DeviceNet master-slave network is 63.

DeviceNet I/O
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DeviceNet Addressing 

The addressing of the Reader DeviceNet I/O requires 2 bytes.  The
following tables show the byte and bit address for each of the inputs
and outputs.  Use these charts when setting up the DeviceNet
scanner.

I/O data is addressed and sent to other DeviceNet devices through a
DeviceNet scanner (Catalog No. 1771-SDN or 1747-SDN).  To
configure the scanner, you will need to provide the size of the I/O
data, the beginning byte and bit number of the data and the
destination of the I/O data.

Poll Data Structure (DeviceNet Inputs)

Description Byte # Bit #

DeviceNet Input #1 0 0

DeviceNet Input #2 0 1

DeviceNet Input #3 0 2

DeviceNet Input #4 0 3

DeviceNet Input #5 0 4

DeviceNet Input #6 0 5

DeviceNet Input #7 0 6

Poll Tx Size = 1 Byte

Response Data Structure (DeviceNet Outputs)

Description Byte # Bit #

DeviceNet Output #1 0 0

DeviceNet Output #2 0 1

DeviceNet Output #3 0 2

DeviceNet Output #4 0 3

DeviceNet Output #5 0 4

DeviceNet Output #6 0 5

DeviceNet Output #7 0 6

DeviceNet Output #8 0 7

DeviceNet Output #9 1 0

DeviceNet Output #10 1 1

DeviceNet Output #11 1 2

DeviceNet Output #12 1 3

DeviceNet Output #13 1 4

DeviceNet Output #14 1 5

DeviceNet Output #15 1 6

Poll Rx Size = 2 Bytes

Note:  Input #8 and Output #16 control the transmission of bar code
message data using DeviceNet master-slave.  Refer to Chapter 10.
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Seven discrete DeviceNet inputs are available for each Reader.
These inputs are listed on the available inputs on the Input & Output
dialog.  Use these inputs like any other trigger source.  The
DeviceNet Input dialog allows you to assign a name to the input.
Open this dialog by selecting a DeviceNet Input from the list on the
Input & Output dialog and clicking the Edit  button.

Each input can only be used once and inputs are only available for
use by the Reader configuring the input.  For example, if you
configure a DeviceNet input for Bar Code Reader 2, you will only be
able to use DeviceNet inputs from Bar Code Reader 2.   Once
selected, an input will not be available for use by other
configurations (appears greyed out on dialogs).

If you need to trigger more than one function using a single input,
“chain the triggers”.  For example, DeviceNet Input #1 triggers
decoding on a Reader.  The match function for the Reader is then
triggered by the [decoder] function.

Configuring DeviceNet 
Inputs

☞ Or double-click on a
DeviceNet Input to open the
dialog.
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Fifteen discrete DeviceNet outputs are available.  These outputs are
listed on the available outputs on the Input & Output dialog.  Use
these outputs like any other output.  The DeviceNet Output dialog
allows you to assign a name to the output.   Open this dialog by
selecting a DeviceNet Output from the list on the Input & Output
dialog and clicking the Edit  button.

Each output can only be used once.  Once selected, an output will
not be available for other configurations (appears greyed out on
dialogs).

Configuring DeviceNet
Outputs

☞ Or double-click on a
DeviceNet Output to open the
dialog.
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This chapter describes the message data the Reader transmits after
decoding bar code symbols.

Section Page

What is a Message? 10–2

Message Samples 10–3

Defining Messages 10–4

Configuring the Bar Code Contents of a Message 10–6

Configuring Optional Fields for a Message 10–8

Configuring the Format of a Message 10–10

DeviceNet Messages 10–12

Using Pass-Through to DeviceNet 10–15

Chapter Objectives
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A message is a series of data strings that the Reader transmits when
bar code symbols are decoded.  These fields contain decoded bar
code data and other information such as package count.  Messages
are sent to a host at the end of a trigger or after a valid package.

The message format is shown below.  The length of the fields
(number of ASCII characters) is shown in parentheses.

ASCII BAR CODE DATA

11. Counter (10)

8. Field Delimiter (0 or 1)

7. Bar Code Data or No-Read Message, 0 to 64 characters, including start,
stop, and check characters.  Up to 64 characters will be sent for each field
read (fields separated by a delimiter).  Codabar Stop Character follows
Codabar Check Characters, if sent.

4. Source (0 or 2) contains DeviceNet Address (MAC ID)

3. Field Delimiter (0 or 1)

2. Header Message (0 to 32)

1. Source Identifier (0 to 8)

9. Field Delimiter (0 or 1)

13. Transmission Check (0 to 2)
12. End Message (0 to 3)

5. Symbology (0 or 2)

6.  Margin (0 or 2)

10. Scan Count (0 or 2)

Some fields are provided by the decoded bar code symbol.
However, most of the fields are specified by the Message Format and
Field Edit dialogs.

What is a Message?
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This section shows some sample messages.

Example 1:  If one Code 39 label is decoded, the decoder transmits:

End Message Characters
Package Count

End of Package Double Delimiter
Bar Code Data

Code 39 Symbology Type Indicator

Header Message

Field Delimiter

Source Identifier

Source

Example 2:  If two Code 39 labels are scanned on a single package,
the decoder transmits:

Source Identifier
Header Message

End Message Characters
Package Count

End of Package Double Delimiter

Bar Code Data
Code 39 Symbology Type Indicator

Field Delimiter

Bar Code Data
Code 39 Symbology Type Indicator

Field Delimiter

Source

Source

Example 3:  If a No-Read occurs, the decoder transmits:

End Message Characters

Package Count

End of Package Double Delimiter
No-Read Message

Header Message

Field Delimiter

Source Identifier

Source

Note:  Message packages can consist of both bar code strings and
no-read strings.

Message Samples
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From the Message dialog, you configure the content and format of
bar code messages sent to the host.

Open the Message dialog by selecting the Message button on the
main Project dialog.

Note:  If Triggered By is not 
enabled, data will not be transmitted
to a host.

Field Definitions

Displays a list of defined message fields.  Initially, the Field
Definitions area is blank.

Select To

New Open the Message Field dialog allowing you to create a new message
field.

Edit Open the Message Field dialog for the highlighted message field.

Cut Cut the highlighted message field to the clipboard.

Paste Move the message field from the clipboard to Field Definitions listing.
Select Paste to make copies of the field.

Defining Messages
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Triggered By

Specifies the trigger that sends a message to the host.  The Reader
sends messages at the end of a trigger or when data is available.

Note:  If DeviceNet is selected as the host (page 10–10), messages
are queued until requested by the DeviceNet master (see Message
Flow Control page 10–13).  The trigger controls when messages are
placed in the queue.

Select To

Enable Enable the message trigger.  If not selected, mes-
sages are not sent.

Device Select the Reader that is the source of the
trigger.

Input Select the input on the specified device (Reader) to
trigger a message send.

Send at End of Trigger Send a message at the end of a trigger.

Send When All Fields Are Sa-
tisfied.

Send a message immediately when all of the ex-
pected fields have been decoded or at the end of
the trigger.

Any configured input is available as a message trigger, including:

Select To

Package Detect Use the package detect input as the trigger source.

Timer Use the internal Reader timer as the trigger source.

ASCII 
Command

Use an ASCII command as the trigger source.

Input Timer Use the input timer as the message trigger.

DeviceNet 
Inputs 1�7

Use a DeviceNet input as the message trigger.

[Decoder] Use the decode trigger as the trigger source.

[Package] Use the package trigger as the trigger source.

[Match Table] Use the match table trigger as the trigger source.

[Message] Use the same message trigger used by another Reader.
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The Message Field dialog defines the bar code contents of messages
sent to another device.  Open this dialog by selecting the New or
Edit  button on the Message dialog.

Important:  If you leave the find String
blank and select Match Exactly, all de-
coded data is sent.

Field Name

Specifies a unique name for the bar code data field.

Find String

Specifies the bar code data string for which the Reader searches.
When the string is found, the Reader replaces the bar code data with
the replacement strings (see Message Field Edit Dialog). The find
string may contain search metacharacters, refer to Appendix C.

Important:   If you leave the Find String blank and select Match
Exactly, all decoded bar code data is sent.  This functions the same as
using the .*  metacharacters in the Find String and deselecting Match
Exactly.

Select To

Match Exactly Enable/Disable metacharacters.  When selected, metacharact-
ers are normal ASCII characters.

Disable Disable the find and replace function.  When selected, the
Reader will not search for strings within the decoded bar code
data.

Configuring the Bar Code
Contents of a Message

☞ Configure a message so that it 
contains only data required by 
the application to increase 
response times.
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Symbol Source

Specifies the source(s) of the bar code data in the message field.
Field data may come from several sources.  To select more than one
Reader, hold down the [Shift] or [Ctrl] keys while making the
selection.  [Shift] selects a group of consecutive listings and [Ctrl]
selects nonconsecutive listings.

Bar Code Labels & Symbols

Specifies the label or symbol data to include in the message field.
Only the symbol and label data available from the selected Readers
is displayed.   The message field may contain data from one or more
Readers.  To select more than one label or symbol, hold down the
[Shift] or [Ctrl] keys while making the selection.  [Shift] selects a
group of consecutive listings and [Ctrl] selects nonconsecutive
listings.



10–8

Publication 2755-838

The Message Field Edit dialog configures optional data fields and
parameters to include in messages sent to the host.  Open this dialog
by selecting the Edit  button on the Message Field dialog.

Include in Field

Displays a list of data fields to include in the message.

Select: To:

Source Include the DeviceNet Address (MAC ID) in a message.

Margin Include 2 digit margin of the decoded symbol in a message.

Symbology Include the 2-digit symbology code in the message.
 
01 = Code 39 08 = Code 128
02 = I 2 of 5 09 = Pharma Code
03 = Codabar 10 = Code 93
04 = UPC-A 11 = Discrete 2 of 5
05 = UPC-E 12 = USPS 2 of 5
06 = EAN-8 13 = Matrix 2 of 5
07 = EAN-13

Type

Determines the data type in which to send messages.

Select: To:

Text Send data in an ASCII format.

Configuring Optional
Message Parameters
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Alignment

Determines the alignment of data in messages.

Select: To:

Left Align data with the left side of a field.

Right Align data with the right side of a field.

Minimum Length

Specifies the minimum number of characters (0-64) required in a
message field.  Message fields less than the minimum length are
padded with a fill character.

Fill Character

Specifies the character to use for padding positions in a message
field that is less than the minimum length.  Use any ASCII character
(0 to 255) as a fill character.  The default = 32 (Space).  Refer to
Appendix A for an ASCII conversion chart.

Replacement Strings

Specifies the exact string and/or metacharacters to use in the
replacement string.

Important:   If you leave the Pass string blank and Match Exactly
checked, all decoded data is placed in the message field (functions
same as &  metacharacter).  Some earlier firmware releases required
a Pass rule.

Note:  Replacement string fields support metacharacters.  Refer to
Appendix C for a description of the available metacharacters.  Make
sure that the characters you enter are not misinterpreted as a
metacharacter string or unintended operation may result.

Select: To:

Pass Specify a string to replace the bar code data field when the find
string is located in the message.  If no string is provided and
Match Exactly is checked, all decoded data is placed in the
message.

Fail Specify a string to replace the bar code data field when the find
string is not located in the message.  If no string is provided, fill
characters are inserted into the message; the number of fill
characters depends upon the minimum message length.
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The Message Format dialog configures the format of messages sent
by the Reader.  Open this dialog by selecting the Format button on
Message dialog.

Header

Specifies the ASCII string to send as a message header.  Enter 1 to
32 characters, a blank field indicates that no header is sent.  The
header may contain non-printable characters, see page A-3.

Trailer

Specifies the ASCII string to send as a message trailer.  Enter 1 to 32
characters, a blank field indicates that no trailer is sent.  The trailer
may contain non-printable characters, see page A-3.

Source ID

Specifies an identifier to indicate the source of the data.  Each
Reader can use a different identifier to track the source of each
message, for example “Reader #3”.

Swap and Pad

When selected, high and low data bytes swap positions.  Select swap
bytes when sending the message to a PLC/SLC.  An odd number of
bytes is padded with a zero so that messages always contain an even
number of bytes.  Note:  Pass-Through data is not swapped.

Configuring the
Message Format
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Field Delimiter

Specifies a 3-digit decimal equivalent of an ASCII character to
indicate the start and end of bar code label data.  When Disable is
selected, delimiters are not inserted into the message data.

Field Data

When selected, bar code field data is included in the message.

Scan Count

When selected, sends the number of scans decoded within the
decoder trigger period (up to 99).

Counter

Select: To:

Include Include counter data in each message.

Device Specify the Reader source of the counter data.

Counter Specify the counter data (package or match entry) to include in
the message.

Message Destination

Specifies the communications port connector through which bar code
messages are sent.

Select: To:

DeviceNet Send messages out through the DeviceNet port.  See next
page for additional information.

Serial Port Send messages out through the RS-232, RS-422, or RS-485
port connectors.

Handshaking

When selected, allows the PLC or SLC to control the transfer of
message data.  Refer to DeviceNet messages (next page).

Current Message Size

Displays the message size in bytes as it is configured.  Size is
updated as selections are made.  Use the message size when setting
up your DeviceNet scanner message addressing (see page 10–13).
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DeviceNet Master-Slave Communications

The AdaptaScan Reader connects to other DeviceNet slave devices
through either a PLC (Catalog No. 1771-SDN) or SLC (Catalog No.
1747-SDN) DeviceNet Scanner.  The AdaptaScan operates as a slave
device to the DeviceNet scanner.

Message Formatting

Bar code message data sent to an SDN (DeviceNet) scanner is
formatted the same as messages sent through the serial port.  Note
the following when formatting messages:

• If a replacement string is longer than the length specified in the
SDN scanner addressing, the message is truncated.

• If a replacement message is shorter than the length specified in
the SDN scanner addressing, the message is padded with the
specified fill character.

• If a pass/fail replacement string is longer than the length specified
in the SDN scanner addressing, the least significant bytes are
truncated.

Note:  You must select DeviceNet option as the message destination
on the Message Format dialog.

DeviceNet Messages
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Message Addressing

Message Data is formatted the same as messages sent through the
serial port.  When setting up the DeviceNet scanner for addressing
message data, use the following table.

Description Word # Byte # ➀➁

Number of Characters (LSB)
2

2

Number of Characters (MSB)
2

3

First Message Character
(Beginning of Message)

3
4

Other Message Characters
from left to right

3
5 �

Last Message Character
(End of Message)

3+ N where N is the number of characters in
the message.

➀  Bytes #0 and #1 (word 1) are reserved for Discrete I/O.  See Page 9–14.
➁  Poll Rx Size = 4 + (# of Characters in string).

Message data is addressed and sent to other DeviceNet devices
through a DeviceNet scanner (Catalog No. 1771-SDN or
1747-SDN).  To configure the scanner, you will need to provide the
size of the message data (see page 10–11), the beginning byte and bit
number of the message and the destination of the message data.

Message Flow Control (Handshaking)

DeviceNet Input #8 and Output #16 control the transmission of bar
code messages when using DeviceNet master-slave.  Refer to
DeviceNet I/O in Chapter 9.  Message flow control (handshaking)
lets the controller know that data is available and keeps the Reader
from sending out messages faster than they can be received.  Your
controller logic program must initiate transfers of the message data
and set the DeviceNet Input #8 (Send Next Data) for message flow
control.

New Data

Is indicated by changing the state of Discrete Output #16 of the
DeviceNet I/O.  A change of state (0�1) indicates that message data
is new.

Send Next Data

By changing the state of Discrete Input #8 of the DeviceNet I/O, the
PLC/SLC program control indicates the controller is ready to receive
the next message.

Note:  The Application Guide (Publication 2755-6.8) included with
this manual contains an application note for using DeviceNet Master
/ Slave communications.
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Flow Control Example

The following shows how DeviceNet Input #8 and Output #16
control the transmission of messages.  Output #16 is changed by the
Reader and Input #8 is changed by the controller.

DeviceNet Scan Number Message Data DeviceNet 
Output #16

DeviceNet
Input #8

1 - Poll - OFF (0)

1 - Response No Message Sent OFF (0)

2 - Poll - ON (1)

2 - Response Message 1 Sent ON (1)

3 - Poll - OFF (0)

3 - Response Message 2 Sent OFF (0)

Note:  You can disable handshaking by deselecting the handshake
checkbox (see page 10–11).  With handshaking disabled, it may be
possible to miss data if the Reader decodes data too fast for the
controller.  In addition, identical data may not be read unless data
that changes such as package count is added to the message sent by
the Reader.
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The Serial Port dialog (page 8–5) contains a check box for Enable
Pass-Through to DeviceNet.  With this box selected, data from the
serial port is passed through to a DeviceNet master-slave network.

PLC-5 with 1771-SDN (DeviceNet Scanner)

Hand-Held Scanner

User Supplied Cable to
AdaptaScan RS-232 Port

To AdaptaScan
DeviceNet Port

To Other
DeviceNet Devices

To connect a device such as a decoded hand-held scanner, you will
need to create a custom cable.  The AdpataScan Reader user manual
(Publication 2755-837) shows the AdaptaScan serial port
connections.

In the above example, the scanner data is input directly into the
AdaptaScan RS-232 serial port.  The AdaptaScan reader outputs the
data to its DeviceNet port.  To the rest of the DeviceNet network it
appears that the data is coming directly from the reader.

Note:  If the serial port receives more characters than the controller
is configured to accept, 0s will appear in the data field.  The 0s
indicate that the file size is being exceeded.

Using Pass-Through to
DeviceNet
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This chapter describes match table operations.

Section Page

Helpful Hints 11–1

What is a Match Table? 11–2

Match Table Applications 11–3

Match Rules 11–3

Defining a Package 11–4

Using Auto-Load 11–5

Configuring Match Tables 11–7

Configuring the Contents of Match Tables 11–9

Configuring Match Table Outputs 11–11

Configuring the Match Entry Counter 11–12

Configuring a Package Definition 11–13

Configuring a Package Using Match Table Entries 11–15

Configuring Package Outputs 11–17

Configuring the Package Counter 11–18

Configuring the Auto-Load Trigger 11–19

Viewing Readers with the Same Trigger Source 11–20

When creating match tables:

• Match table functions are selected from a list to define a package.
You must define the match table functions (entries) before
defining a package.

• You can use search metacharacters in match functions.  Refer to
Appendix C for a description of these characters.

   Chapter Objectives

   Helpful Hints
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A match table contains bar code data and/or metacharacters entered
by an operator.  The Reader compares the match table entries with
the decoded bar code data. When matches are found, the Reader
determines whether or not a package has been read or activates
discrete output(s).  A Reader match table may contain up to 128
match entries.

Match Function 1 =  456789
Match Function 2 = 123456
Match Function 3 = 245678

Match Table Definitions Package Definitions

Package 1 = Match Function 1

Package 2 = Match Function 2 and 3

For Example, assume the following match table entries and package definitions.

Reader 1

Reader 2

Reader 2 Symbols sent to
Reader 1 match table.

Reader 1 scans a package label with a label content of
999888 which does not correspond with any match table entry.
Reader 2 scans a label on the same package with a content of
123456 and 245678 which corresponds with the match table
definition for package 2.

Reader 2 turns on a discrete output of Reader 1 as a result of
the match.  The discrete output of Reader 1 sets a diverter to
route the package to its proper location.

Reader 1

Reader 2

Reader 1

Reader 2

 ➁

➂

 ➀

Reader 1 scans a package label with a label content of
456789 which matches the package 1 definition.

Reader 1 turns on a discrete output as a result of the match to
route the package to it’s proper location.

Diverter

Diverter

What is a Match Table?
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Verify Labels

When verifying a label, the Reader compares the decoded data with
the expected label content entered in a match table.

Reader

Decoded Data (5/95) = Match Table (5/95)
Label Verified

Sort Products

When sorting products, the Reader compares decoded data with
match code entries.  Each match table entry is linked to a different
output. When a package is read, the match table result turns on the
corresponding output.

Reader

Reader

Instead of entering the exact bar code data in a match table, you can
enter a rule (using metacharacters) to define a category of symbols.
For example, a rule that can match any symbol that begins with 231
and ends in 09.

All Match Rule: 231 . . . 09

See Appendix C for details on metacharacters.

Match Table Applications

Match Rules
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The Reader determines when a package is read by matching the
decoded bar code symbols with symbols entered in a match table.  
A valid package is decoded when all of the decoded symbols
correspond with the specified match table entries for the package.

Decoded Bar Code Data
016759089
287944498 Match Function

Match Entry

Match Table 
Package Definition

016759089
287944498

= Package Read

 ➀

 ➁

 ➂

 ➃

Reader decodes two symbols ➀  on the package.

Two Match Entry ➁  functions are defined, one for each value.

Decoded bar code symbols ➀  match the match table package definition ➂  resulting
in a valid package ➃ .

The Match Table ➂  defines a Package as two match entries.

An output module can be triggered whenever a match occurs or a
package is decoded.  This allows you to design sorting and label
verification functions.  In addition, the Reader has both match entry
and package counters for tracking the number of symbols or
packages read.

Defining a Package
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Auto-Load allows you to enter a Match Entry data string by scanning
the desired bar code label.  Usually, the Auto-Load input is provided
by a switch or push button connected to one of the AdaptaScan I/O
in the wiring base. 

To configure a Match Entry for Auto-Load:

1. On the Match Function dialog (page 11–9), select Auto-Load as
the function.

2. Use the Auto-Load Trigger Source dialog (page 11–19) to define
the trigger source.

After the AdaptaScan has been configured and running, Auto-Load
symbol data by triggering the decoder while the desired symbol is
being scanned and decoded.  The Auto-Load input must be energized
before the decoder is triggered and must remain on until the decoder
trigger goes off.

Decoder Trigger

Trigger

Data
Scanned

Auto-Load Triggered Prior
to Decoder Trigger

Auto-Load Trigger

Keep Auto-Load Trigger 
On Until Decoder Trigger is Off.

The following page shows a typical Auto-Load sequence.

Notes: 
A string that is auto-loaded does not appear in the Rule field of the
Match Function dialog.

Auto-Load clears the Match Counters.

Using Auto-Load
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Here is an example of an Auto-Load using a push button as the
trigger source.

Match Table

Match Table
Function = Auto-Load
Rule =

➀ The match table function is set for Auto-Load.

➁ Auto-Load is triggered by operator prior to Package
Detect trigger (both Package Detect and Auto-Load
triggers required).  Auto-Load trigger is maintained (but-
ton pressed) while the Reader scans the label data.

➂ Auto-Load trigger is turned off (operator releases
button).  The decoded bar code data is entered into
the match table definition.

Function = Match Entry
Rule = 016759089

④ Scan the same label again.  Verify that the correct
data was entered into the match table by observ-
ing the output assigned to the match table.
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The Match Table dialog configures the operation of the match table
functions.  Open this dialog by selecting the Match Table button on
the main Project window.

Opens Packages Dialog

Opens AutoLoad Trigger Dialog

Match Functions

Displays a list of match table functions that have been defined.

Select: To:

New Open the Match Function dialog allowing you to create a new
match table definition.

Edit Open the Match Function dialog for the highlighted match table
definition.

Cut Cut the highlighted match table definition to the clipboard.

Paste Move the match table definition from the clipboard to a match
functions listing.  Select Paste to make copies of the match
table definition.

Configuring Match Tables
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Triggered By

Specifies when the Reader activates an output based on the results of
the match table.  Items that appear in brackets specify the same
trigger assigned to the specified function.  For example selecting
[Decoder] indicates that the match table uses the same trigger
assigned to the decoding function.

Select: To:

Device Specify the Reader that is the source of the trigger.

Input Specify the input used to provide the timing of a match table
output.

The following selections are typical trigger inputs.

Select: To:

Package Detect Use the package detect input as the trigger source.

Timer Use the internal Reader timer as the trigger source.

ASCII 
Command

Use an ASCII command as the trigger source.

[Decoder] Use the decode trigger as the trigger source.

[Package] Use the package trigger as the trigger source.

[Message] Use the message trigger as the trigger source.

[Match Table] Use the match table on another Reader as the trigger source.
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The Match Function dialog defines both the contents of the match
table and the source of the symbols to be matched.  Open this dialog
by selecting the New or Edit  button on the Match Table dialog.

Functions

Specifies the type of match required between a match table entry and
decoded bar code data.

Select: To:

Match Entry Specify a match occurs when the contents of the Rule field
matches data from a bar code symbol.

Symbols Equal Specify a match occurs when the same symbol is decoded
from each of the specified sources.

Auto-Load Specify that bar code data is inserted into the match table as
the data is decoded.  After Auto-Load has been completed, the
match function automatically changes to Match Entry.

Match Function Name

Specifies a unique name for the match function.  This name appears
in the Match Table functions list and as a selection on the Packages
dialog where match functions are selected to define a package.

Symbol Source

Specifies the Reader decoding the bar code data being compared
with the match table entry.  When a Reader is selected, the label
setups and label symbols that have been assigned to the Reader
appear in the Bar Code Labels and Symbols box.

Configuring the 
Contents of Match Tables

☞ Or double-click the match 
function to open the dialog.
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Bar Code Labels and Symbols

Specifies the symbols or labels to be matched against the contents of
the match table.  Data from multiple Readers may be compared with
a match table entry.  To select more than one symbol, hold down the
[Shift] or [Ctrl] keys while making the selection.  [Shift] selects a
group of consecutive listings and [Ctrl] selects nonconsecutive
listings.

Rule

Specifies either the exact contents of the bar code symbol to match
and/or a metacharacter string that defines parameters of symbols
being matched.  Refer to Appendix C for a list of the metacharacters.

For example, to match any number of occurrences of any character,
enter the metacharacter string .*

Disable

When selected, disables the match function.  When disabled, the
Reader will not search for bar code data that matches the Rule entry.

Match Exactly

Enables / disables metacharacters.  When selected, metacharacters
are read as normal ASCII characters.  When not selected, certain
characters (metacharacters) perform special functions as described in
Appendix C.
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The Match Function Output dialog specifies the outputs that are
energized when decoded symbols match data entered in the match
table.  Open the Match Function Output dialog by selecting the
Outputs button on the Match Function dialog.

Available Outputs

Displays a list of the discrete outputs you can assign to this function.

Output To

Displays a list of the discrete outputs assigned to this function.

Add

Only active when an output is highlighted in the Available Outputs
list.  This button assigns the highlighted output to the match table.
Once assigned, the output appears in the Output To list.

Remove

Only active when an output is highlighted in the Output To list.  This
button removes the highlighted output from the Output To list.

Configuring 
Match Table Outputs

☞ Or double-click an output 
name in the Available Outputs 
list to assign it to the match 
table.
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The Match Entry Counter dialog configures the match entry counter.
The match entry counter increments each time decoded symbols
match the data entered in the match table.  Open the Match Entry
Counter dialog by selecting the Counter button on the Match
Function dialog.

Count Direction

Determines whether the counter value increments or decrements
each time a match occurs.

Select: To:

Up Increment the counter value by 1 each time a match occurs.

Down Decrement the counter value by 1 each time a match occurs.

Initial Value

Specifies the initial value loaded into the counter.  The initial value is
loaded into the counter the first time the application is run or when
power is cycled to the Reader.

Rollover Value

Specifies the value at which the counter resets to the initial value.
For example if the rollover value is 5, the counter would count: 0, 1,
2, 3, 4, 5, 0, 1, 2, . . .

Configuring the 
Match Entry Counter
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The Packages dialog uses match functions to define a package. 
Open the Package dialog by selecting the Package button on the
Match Table dialog.

Package Definitions

Displays a list of packages previously defined.

Select: To:

New Open the Package dialog allowing you to define a package
using the match functions entered in the match table.

Edit Open the Package dialog for the highlighted package definition.
You can also double click the package definition name to open
the Package dialog.

Output To Open the Package Outputs dialog for the highlighted package
definition.

Cut Cut the highlighted package definition to the clipboard.

Paste Move the package definition from the clipboard to the Package
Definitions list.  Select Paste to make copies of a cut package
definition.

Configuring a 
Package Definition
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Triggered By

Specifies when the Reader activates an output if a package is
decoded.  Items that appear in brackets specify the same trigger
assigned to the specified function.  For example, selecting [Decoder]
indicates that packages use the same trigger assigned to the decoding
function.

Highlight the package definition you want to assign a trigger for and:

Select: To:

Device Specify the Reader that is the source of the trigger.

Input Specify the input to provide the timing of a package output.

The following selections are typical trigger inputs.

Select: To:

Package Detect Use a package detector as the trigger source.

Timer Use the internal Reader timer as the trigger source.

ASCII 
Command

Use an ASCII command as the trigger source.

Input Timer Use input timer 1 or 2 as the trigger source.

[Decoder] Use the decode trigger as the trigger source.

[Match Table] Use the match table trigger as the trigger source.

[Message] Use the message trigger as the trigger source.

[Package] Use the package trigger on another Reader as the trigger
source.
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The Package dialog uses match table entries to define a package. 
Open the Package dialog by selecting the New button on the
Packages dialog.

Package Name

Specifies a name for the package definition.  This name appears in
the list of package definitions on the Packages dialog.

Configuring a Package 
Using Match Table Entries
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Mode 

Specifies the type of match that will activate an output or increment
a counter:

Select: To activate the output:

Read Package when the Reader decodes a symbol for each selected match.
Use the Read Package mode to verify the presence of a good
label.

No-Read 
Package

when a no-read occurs.  Use the No-Read condition to detect
missing or damaged labels.  A no-read occurs when a valid
package has not been decoded at the end of a trigger.

Match 
Complete

when bar code data from a package matches all selected
match functions.

Read and 
No-Match

when a valid read occurs but the bar code data does not match
all entries selected.  Use the Read and No-Match condition to
detect incorrect labels.

No-Read or
No-Match

when either a no-read or a no-match condition occurs (the bar
code data does not match any entry in the match table).  Use
the No-Read or No-Match condition to detect incorrect or mis-
sing labels.

No Match 
Complete

when bar code data from a package does not match some or
all selected match functions.

Disable

When selected, disables the package definition.

Output At

Specifies when the package detect is activated, either at the end of
the trigger or when the decoded value(s) match the package
definition.

Match Functions

A list of the available match table functions that can be used to
define a package.  To select more than one match function, hold
down the [Shift] or [Ctrl] keys while making the selection.  [Shift]
selects a group of consecutive listings and [Ctrl] selects
nonconsecutive listings.

When all of the highlighted match functions are satisfied, a valid
package has been read.
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The Package Outputs dialog specifies the outputs that are energized
when decoded symbols match the data entered in the match table. 
Open the dialog by selecting the Output To button on the Packages
dialog.

Available Outputs

Displays a list of the discrete outputs that may be assigned to the
match table.

Output To

Displays a list of the discrete outputs assigned to the package.

Add

Only active when an output is highlighted in the Available Outputs
list.  This button assigns the highlighted output to the match table.
Once assigned, the output appears in the Output To list.

Remove

Only active when an output is highlighted in the Output To list.  This
button removes the highlighted output from the Output To list.

Output After

Specifies the number of consecutive matches required before an
output is turned on.  Use this feature to indicate multiple,
consecutive operations such as no-reads, reads, or matches.

Configuring Package Outputs

☞ Or double-click an output 
name in the Available Outputs 
list to assign it to the match 
table.



11–18

Publication 2755-838

The Package Counter dialog configures the operation of the package
counter.  The package counter increments each time decoded
symbols match the match table definition for the package.  Open the
Package Counter dialog by selecting the Counter button on the
Package dialog.

Count Direction

Determines whether the counter value increments or decrements
each time a package is read.

Select: To:

Up Increment the counter value by 1 each time a package is read.

Down Decrement the counter value by 1 each time a package is read.

Initial Value

Specifies the initial value loaded in the counter.  The initial value is
loaded the first time the application runs or when power is cycled to
the Reader.

Rollover Value

Specifies the value at which the counter resets to the initial value.
For example if the reset value is 5, the counter would increment 0,1,
2, 3, 4, 5, 0, 1, 2, 3, 4, 5, 0, 1, 2, ...

Configuring the 
Package Counter



11–19

Publication 2755-838

The Auto-Load Trigger Source dialog configures the input which
initiates the the auto-load function.  When triggered, auto-load
automatically enters decoded bar code data into match table entries
designated for auto-load.  Open the Auto-Load Trigger Source dialog
by selecting the Auto-Load button on the Match Table dialog.

Enable

Enables and disables the autoload feature.

Auto-Load Trigger

Specifies the input to initiate an auto-load.  Once initiated, auto-load
remains active until either:

• the end of the auto-load trigger

• match table entries designated as an auto-load function are filled

Select: To:

Device Specify the Reader that is the source of the trigger.

Input Specify the input to provide the auto-load trigger.

Configuring the 
Auto-Load Trigger
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The Used By dialog lists other Readers that use the package or match
table configurations as trigger sources.  Use this dialog when you
make changes to a match table / package definition and you want to
view or access configurations assigned to the same trigger source.
Open the Used By dialog by clicking the Used By button on the
Match Table or Packages dialog.

Currently Used By

Displays the Reader configurations that use the same package or
match table trigger source.  Highlight the package or match table
definitions you want to access and click the Goto button.

Viewing Readers 
with Same Trigger Source

☞ Or double-click the package or
match table definition and then
click the Goto button.



 
Chapter   12

�

���	�������
���	��
����	�����	���

This chapter describes how to download configurations from a
computer to a single Reader or multiple Readers.

Section Page

Helpful Hints 12–2

Upload/Download Connections 12–2

Configuration Cable 12–2

Downloading a Configuration 12–3

Uploading a Configuration 12–5

When transferring configurations:

Through the configuration port (direct connection)

• Use cable (Catalog No. 2755-NC48 Series B Reader, 2755-NC43
Series A Reader) and the Configuration Port connector on the
Reader for downloads.

You can also configure a Reader by connecting a computer to a
serial port in the wiring base. (On the Serial Port dialog, you must
select DF1 protocol and select the Scanner Protocol check box).

• Make sure the cable is connected to the appropriate serial port of
your computer.

• Communication parameters for your computer’s serial port are set
under Preferences on the View menu.  Configuration Port  must
be selected as the communications channel.

Through a DeviceNet network

• A DeviceNet communications card and driver must be installed
on your computer.

• On the Preferences dialog (View >Preferences), DeviceNet must
be selected as the communications channel.

• Refer to the user instructions for the communication software you
are using such as RSLinx.

Overview

Helpful Hints



12–2

Publication 2755-838

AdaptaScan software can download a configuration to a single
Reader or multiple Readers on a DeviceNet peer-to-peer network.
AdaptaScan Bar Code Reader configurations are downloaded:

• directly through the Configuration Port connector on the Reader

• through any Reader on the same DeviceNet peer-to-peer network

When Configuration Port  is selected as the communications
channel, a configuration cable is required.   The configuration cable 
(Catalog No. 2755-NC48 Series B Reader, 2755-NC43 Series A
Reader) connects the configured communications port (see
Preferences, page 2–18) of the computer running AdaptaScan
software to the Configuration Port connector of the Reader.
Downloads may also be done through the Reader serial
communication ports when scanner protocol is selected (see page
8–6).

Configuration
Port Connector

Personal Computer

Configuration Cable
(Catalog No. 2755-NC48 Series B

2755-NC43 Series A)

9 to 25 Pin Adapter
may be required

9 Pin Male
D Connector

4 Pin Female
Circular Connector

Note:  If you are transferring applications over a DeviceNet network,
refer to the instructions provided with your computer’s DeviceNet
communications card for connections.  The Reader DeviceNet
connections are described in the AdaptaScan Reader user manual
(Publication 2755-837).

Upload/Download
Connections

Configuration Cable 
(for direct transfers)
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This section shows how to download a configuration to one or more
Readers.  Verify that your computer is connected to a Reader as
shown on previous page.

To download a configuration to a Reader:

1. Run the AdaptaScan software.

The AdpataScan database dialog opens.

Highlight
Project

2. Select and open the project containing the configuration you want
to download.

3. From the Communications menu, select Go-Online.

The Reader will be detected (if properly connected) and displayed
in the project window.

4. Make sure each device within the project has a unique DeviceNet
address (even if you are not using DeviceNet communications).
With the Reader name highlighted, click the Device button to
open the Device dialog and set the address.  Click Apply  to send
the address to the Reader.

If the Device is online but not in the project 
database, the following dialog is displayed:

If the Device is online and in the current project 
database, the following dialog is displayed:

Set to
Unique

Address

5. From the Project window, select the Reader or Readers to which
you want to download a configuration.  To select multiple
Readers, hold down the the [Shift] or [Ctrl] control keys while
making the selections. [Shift] selects a group of consecutive
listings and [Ctrl] selects nonconsecutive listings.

Downloading 
a Configuration
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6. Click the Download button to download configurations to the
selected Readers.

The following message appears during the download.

Resetting.  Please Wait . . .

Sending.  Please Wait . . .

When the download is complete, these messages disappear.

Connections to Other Readers

If you attempt to download a configuration to a Reader that has
connections to other Reader(s) not selected for the download, the
following dialog is displayed.

The dialog shows each group of Readers that are linked together
(share information).  If the Readers being downloaded contain more
than one group, use the Previous and Next Group buttons to view the
other groups

Here is an example.  Assume five Readers are configured in two
groups with Readers 1, 2, and 3 linked together and Readers 4 and 5
linked together.  The following will occur:

If a configuration is downloaded to Reader 1, a message is
displayed that Readers 1, 2 and 3 are linked (share information).

If  Readers 1 and 4 are selected for download, a message is
displayed showing that Readers 1, 2, 3 are linked together in a
group and Readers 4 and 5 are linked together in a group.

If all the Readers in a group are selected for download, such as
Readers 1,2, and 3,  no message is displayed.



12–5

Publication 2755-838

The following shows how data is uploaded from a Reader to the
AdaptaScan Software.

1. Open or create the project in which you want to upload the
Reader configuration.

2. Make sure the configuration cable is connected to the scanner
programming port.  Note:  You can also transfer files using a
DeviceNet network connection to your computer (refer to page
2–18).

3. From the Communications menu, select Go-Online.

The Reader will be detected (if properly connected) and displayed
in the project window.

Note:  If you go on-line with a new project and the project
window doesn’t display any devices, check the query preferences
as described on page 2–19.

Uploading a Configuration
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4. Highlight the Reader configurations you want to upload.
Readers selected for upload may or may not be part of the current
project but only select Readers that are online (online Readers
display the connection icon) 

5. On the Project Window, click the Upload button or click the
upload icon on the toolbar .

The Reader configuration is uploaded to the AdaptaScan
Software (in this example Reader 1).

Uploaded
Configuration

6. If you open the uploaded configuration, note that all of the
configuration names are set to their default values.  The Reader’s
label setup data is added to the existing label setups currently in
the project.  Shown below is the Bar Code Labels dialog.

Uploaded
Label Setup

If you upload the same label data from the same or different
Reader, it will use the previously existing label from the project.
A duplicate label setup is not created.

First Label Setup
Uploaded
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7. You can modify the uploaded configuration as required and then
download the configuration again.

Uploading Interconnected Readers

When a Reader configuration is uploaded that has interconnections
with other Readers, a dialog will be displayed asking whether or not
the connections should be recreated in the project.

If you select to recreate the connections, one of the following will
occur depending on whether or not the interconnected Reader
configuration exists in the project:

• If the interconnected Reader is in the database, the
interconnections between the Readers will be merged.

• If the interconnected Reader is not in the database, a default
Reader configuration will be added beginning with the name
Incomplete.  The uploaded interconnections are then saved using
the newly created configuration.

If you select to maintain the interconnections and an uploaded
default Reader configuration is added in which there is a conflict
with an existing interconnection, you will be prompted to choose
between the uploaded connection or the existing connection.

If you select to keep the existing connection (not the uploaded
connection), the uploaded Reader configuration name will be
changed to begin with Incomplete and the uploaded connection
information is deleted.

If you select not to recreate the connections, the uploaded Reader
configuration will be added to the project with a name beginning
with Incomplete and the uploaded connection information is deleted.
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This chapter describes how to print a project.

Section Page

Setting Up a Printer 13–1

Printing a Project 13–2

Sending a Project to a File 13–4

Printout Contents 13–6

To print a project, a printer must be connected to your computer and
your computer must recognize the printer as a valid printer.  See your
Windows User’s Guide for details on installing print drivers. 

To set up the printer:

1. Choose Print Setup from the File menu.

The standard Print Setup dialog opens.

2. Select attributes for your printer.

3. Click the Options button to enter options specific to your printer.
The Options dialog is different for each printer type. 

4. When done, click OK .  Or click Cancel to exit the dialog without
saving changes.

If your printer is not listed:

1. Check for hardware compatibility between your printer and one
of the printers listed.

2. Check if your printer has an emulation mode that is compatible
with one of the printers listed.

3. You may need to install a print driver for your printer.  Refer to
the Microsoft Windows User’s Guide.

Chapter Objectives

Setting up a Printer
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The Print  command on the File menu lets you print a report on the
current project.  Printouts are useful for tracking project updates and
changes.  You can print out the entire project or the just the
configuration of selected Readers.

To print a project report:

1. Select a project (highlight) in the database window.

2. Choose Print  from the File menu or click the print icon .

The Print dialog opens:

3. Select a Print Quality  that is compatible with your printer.

4. Enter the number of copies.

5. Choose the Setup button to define printer settings.

6. Choose OK  to begin printing.

The application report is sent to the printer.

Printing a Project
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To print a Reader(s) configuration:

1. Select and open the project.

2. In the Project window, highlight the Reader configuration(s) you
want to print.  Hold down the [Ctrl] key while selecting multiple
configurations.

3. Select Print  from the File menu or click the print icon .

The Print dialog opens:

4. Select a Print Quality  that is compatible with your printer.

5. Enter the number of copies.

6. Choose the Setup button to define printer settings.

7. Choose OK  to begin printing.

The Reader configuration report(s) are sent to the printer.
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To send a report to a file, the Generic / Text Only printer must be
installed and connected to the FILE: printer port on your computer.
This printer driver allows you to print text, but not graphics.

You can install this printer from the Printer icon of the Control Panel
window in the Program Manager.  See your Microsoft Windows
User’s Guide for details.

To send a project report to a file:

1. Select Print Setup from the Project menu.

The standard Microsoft Windows Print Setup dialog opens.

2. Select Generic / Text Only from the list of Specific Printers as
shown above.

If Generic / Text Only on FILE: isn’t listed as an available option,
you must install this printer option.

If your application uses large text sizes, open the Options dialog
and enable the Wide Carriage option.

3. Click OK.

4. Choose Print  from the Project menu pull down list.

The Print dialog opens:

Sending Project to a File



13–5

Publication 2755-838

5. Select the  checkbox on the Print dialog

6. Click OK .

The Print to File dialog opens.

7. Enter the name of the file to receive the report.

For Example C:\AB\REPORT\.

8. Click OK to output the report to file.

If the file name already exists, you are given the option of
overwriting it or entering another file name.

Click Cancel at any time to abort operation.
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The AdaptaScan printout provides detailed information on the
contents of a project including

Heading: Provides:

Label Setup Symbols per Scan
Quiet Zone Ratio
Negative Image
Symbol Name
Symbology

Reader Configuration DeviceNet Address
Baud Rate
Description
Heartbeat Rate
Enable Warning

Scanner Laser Light
Scanner Mode
Scan Width
Elevation
Upper Angle
Lower Angle
Increment
Flyback Enabled
Focus Range Units

Decoder Capture Count
Self Triggered Enable
Input Trigger
Label Setup
Low Limit
Scanner Metric
Inter–Symbol No–Read Count

I/O Name
Input or Output
Cyclic On Time
Cyclic Off Time
Delay On
Delay off
Limits (Maximum & Minimum)

Serial Port Scanner Protocol Enabled
Enable Pass–Through to DNet
Terminal Protocol Settings
DF1 Protocol Settings
DH–485 Protocol Settings

Match Table Trigger Input
Package Trigger
Package Setup Configuration
Match Configuration

Message Enable/Disable
Trigger When
Format
Destination

Printout Contents
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This chapter describes how to exchange data between the
AdaptaScan Configuration Software and other Windows applications
that support Dynamic Data Exchange (DDE).

Section Page

Overview 14–1

DDE Format 14–2

DDE Topics 14–2

Read  Performance in Excel 14–3

Read LED Status in Excel 14–4

Read Label Data in Excel 14–5

Read Match or Package Count in Excel 14–5

Writing Excel Data to a Reader 14–6

Excel Read Example 14–7

DDE Through an AdaptaScan Serial Port 14–8

The AdaptaScan configuration software allows you to exchange data
and commands with other application software that supports DDE
such as Microsoft Excel�.  Both software applications must be
running at the same time.  DDE is supported by numerous
applications, including:

• RSI Win series of software

• RSDATA.vbx

• Winlinks

• WinView

• Custom Visual Basic Drivers

• Microsoft Excel

• Microsoft Access

• Microsoft Word

Data can be either read from or written to the Reader depending
upon the DDE function of the software.  When data is read, the
Reader data (such as label data) is provided to other software.  When
data is written, the Reader stores the data (such as match table rule)
or performs a function (such as reset counters).

Reader data is identified by a topic name and an address or instance
number.  Providing other software packages with the Reader topic
name and address/instance allows the software to access the
corresponding data.

Note: The Monitor dialog must be closed before executing the DDE.

   Chapter Objectives

  Overview
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The DDE syntax varies between software packages.  Refer to your
software instructions for the required DDE syntax.  The syntax used
by Microsoft Excel is:

=Server|Topic!’Item’

Where:

Server  is AS_OLP

| is the server / topic delimiter

Topic is the name of the data you want to exchange

! is the topic / item delimiter

Item specifies the node number of the data you want to exchange.

Note:  If the topic name contains a space, the topic name must be
preceded and terminated by quote marks ’Topic Name’.

For example, if you wanted to have Excel show the match count of a
Reader (DeviceNet address 0) you would enter the following string
in a worksheet cell:

=AS_OLP|’MATCH COUNT’!’0’

Only one link to a topic can be made at a time.  For example, you
cannot display Reader performance in more than one Excel
worksheet.

You can use DDE with the following AdaptaScan topics.

Topic Function Data Returned Example using Excel
(default address of 63 shown)

Performance Read performance data. Scanner performance as the number of
symbols decoded within a trigger period
(000 to 100)

=AS_OLP|PERFORMANCE!’63’

LEDS Read status of LEDs. LED Status where 
0 = Off
1 = Yellow
2 = Green
3 = Red
4 = Undefined
5 = Flashing Yellow
6 = Flashing Green
7 = Flashing Red

=AS_OLP|LEDS!’63 1’

Labels Read label data as it is decoded Label Data =AS_OLP|LABELS!’63’

Match Counter Read match counter. Match count =AS_OLP|’MATCH COUNTER’!’63’

Package Counter Read package count. Package count =AS_OLP|’PACKAGE COUNTER’!’63’

Reset Counters Reset package / match counters. 1 = Ok, 0 = Fail =AS_OLP|’RESET COUNTERS’!’63’

Set Match Rule Write match rule to match table. 1 = Ok, 0 = Fail =AS_OLP|’MATCH RULE’!’63’

Trigger Turn trigger on. 1 = Ok, 0 = Fail =AS_OLP|TRIGGER!’63’

Trigger Off Turn trigger off. 1 = Ok, 0 = Fail =AS_OLP|’TRIGGER OFF’!’63’

DDE Syntax

 AdaptaScan DDE Topics
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Reader performance is provided as the number of symbols decoded
within a trigger period.  To share performance data with an Excel
worksheet, enter the following in a cell:

Server Topic Address 0

=AS_OLP|PERFORMANCE!’0’

The Excel cell displays the performance data value:

Read Performance 
in Excel
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Reader LEDs are displayed individually (LEDs 1 to 7) or as an array.
To read LED status as an array, don’t specify an individual LED.  To
share LED data with an Excel worksheet, enter the following in a
cell:

Server Topic Address 2 LED 1

Server Topic Address 2,
Read Array

Individual LEDs

LED Array

=AS_OLP|LEDS!’2 1’

=AS_OLP|LEDS!’2’

LED4

LED5

LED6

LED7

LED1

LED2

LED3

The Excel cell displays the LED status individually or as an array:

Read LED Status
in Excel
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Label data may be read as it is decoded.  To read label data in an
Excel worksheet, enter the following in a cell:

Server Topic Address 2

=AS_OLP|LABELS!’2’

The Excel cell displays the label data:

Reader counter values are provided as a 6 digit value.  To share
counter data with an Excel worksheet, enter the following in a cell:

Server Topic Address 2

Server Data
Topic

Address 0

Package Counter

Match Counter

Instance Number

Instance Number

=AS_OLP|’PACKAGE COUNTER’!’2 6’

=AS_OLP|’MATCH COUNTER’!’0 2’

Read Label Data
in Excel

Read Match or Package 
Count in Excel



14–6

Publication 2755-838

Using DDE, you can also write commands to a Reader.  You can
write to the following: 

• Reset Counters

• Set Match Rule (writes match rule to match table)

• Trigger On

• Trigger Off

After performing the function, the Reader returns data showing the
result (0 = Fail, 1 = Ok).

The following are examples of the write syntax used for Excel.
Refer to the software user manual for the DDE syntax required by
your other software application.

Server Topic Address 0

Server Topic Address 0

Reset Counters

Set Match Rule

Server Topic Address 1

Trigger On

Server Topic

Trigger Off

Instance Number

Match Rule

Address 1

=AS_OLP|TRIGGER!’1’

=AS_OLP|’RESET COUNTERS’!’0’

=AS_OLP|’SET MATCH RULE’!’0 1 abcde’

=AS_OLP|’TRIGGER OFF’!’1’

Writing Commands
to a Reader
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Here is an example of using DDE with Microsoft Excel:

1. Configure the Reader to decode a bar code (refer to Chapter 3).
These instructions assume the Reader is assigned an address of 0.
If needed, click the Device button to open the Device dialog,
change the address, and click the Apply button.

2. Click on the minimize button to reduce the AdaptaScan
configuration software to an icon.  Do not exit the software.

3. Open a Microsoft Excel worksheet.

4. Enter the following data into the cells:

Cell A1:  = AS_OLP|PERFORMANCE!’0’
Cell A2:  =AS_OLP|LEDS!’0 2’
Cell A3:  =AS_OLP|LABELS!’0’

5. The Excel worksheet will display the corresponding data from the
Reader.

Cell A1 shows the scanner performance
Cell A2 displays the Status of LED #2 Trigger/Read
Cell A3 displays the bar code data

6. Move the bar code symbol out of the scan beam.  Notice how the
data displayed in the Excel worksheet automatically updates.

Excel Example
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Dynamic Data Exchange can also occur through devices connected
to an AdaptaScan RS-232 serial port.  DDE through the serial port
functions the same as with the configuration cable (connected to
programming connector).  To use DDE, make sure you select DF1
and enable Scanner Protocol.   Shown below is an example of the
serial port setup should appear.  Make sure the communication
parameters of the host device match the AdaptaScan serial port. 

DDE Through the 
AdaptaScan RS-232 Port
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You can enter non-printable ASCII characters into Header and
Trailer strings.

Non-printable characters may be represented by escape sequences
like \ n (Newline).  The Reader interprets the \ n not as two separate
characters but as a Newline function.  Each escape sequence is
preceded by a backslash \ followed by a letter or number.  To enter
the \ character, use \ \.

Here are the set of escape sequences:

\a = alert (bell) character
\b = backspace
\f = formfeed
\n = newline
\r = carriage return
\t = horizontal tab
\v = vertical tab
\\ = backslash

Note: \1, \2, through \9 represent replacement string metacharacters,
refer to page C–4.

Entering Characters by Specifying Their Equivalent Value

To enter other non-printable characters, specify the hexadecimal
number equivalent value (see ASCII chart on previous page).  

The format for entering a hexadecimal equivalent is \xhh where hh
is the hexadecimal value.  For example; Vertical Tab = \x0B and Bell
= \x07

Entering Non-Printable
ASCII Characters
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This appendix shows the 4 preset read ranges (A, B, C, C+) for the
Catalog No. 2755-SN3, -SN5, -SN8 Readers. You can make manual
range adjustments after selecting a preset read range.

The four preset read ranges allow for easy replacement of an existing
scanner. These read ranges can read bar code labels at various
distances depending on the apparent minimum element width and
scanner to label pitch.

Read range data is based upon the following conditions:

• 95% reads minimum with reader set at maximum scan angle.

• Test label is Code 39, size reference is narrow bar.

• Label orientation on axis with 5� pitch, 25� skew.

Read ranges are measured from the front edge of the wiring base.
Add .58 inches (1.5 cm) for the distance to the scan window.

Read Range
Measured From This Point

Read ranges on the following charts are for preset focus ranges A, B,
C, and C+ at ambient temperature.  These read ranges are based upon
Code 39 labels at 25� skew, 5� pitch.  Typical preset read ranges will
exceed those shown.  The center of the read range will shift up to
15% over the full operating temperature (0 to 50�C) of the Reader.

Different symbologies, skew, and pitch will also result in slightly
different range.  Greater read range may be achieved by manually
adjusting the focus.  Greater read ranges may also be obtained by
reducing the scan angle to less than 100%.  Try different settings to
determine the optimum label positioning, focus range units, and scan
angle for your application.

Overview

Read Ranges

Read Range
Data References
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300 Scans Per Second at Maximum Scan Angle (Usable 60 Degrees)

Narrow
Element

(Mils)

A Range
Inches
(cm)

B Range
Inches
(cm)

C Range
Inches
(cm)

C+ Range
Inches
(cm)

Maximum Range
Inches
(cm)

5 2.5 (6.4) 3.6 (9.2) 3.6 (9.2)

6 2.3 (5.9) 4.4 (11.2) 5.3 (13.5)

7.5 2.0 (5.1) 4.6 (11.7) 7.2 (18.3)

10 1.6 (4.1) 5.7 (14.5) 7.8 (19.8) 11.3 (28.7) 10.9 (27.7)

13 1.5 (3.8) 6.5 (16.5) 6.1 (15.5) 15.1 (38.4) 16.2 (41.2)

15 0.9 (2.3) 6.9 (17.5) 5.4 (13.7) 16.8 (42.7) 14.4 (36.5) 19.6 (49.8) 19.5 (49.5)

20 0.9 (2.3) 8.4 (21.4) 3.9 (9.9) 19.7 (50.1) 10.1 (25.7) 27.0 (68.6) 17.8 (45.2) 25.9 (65.8) 28.4 (72.2)

30 0.9 (2.3) 10.4 (35.5) 2.5 (6.4) 25.0 (63.5) 6.4 (16.3) 36.2 (92.0) 10.6 (27.0) 41.6
(105.7)

42.9 (99.0)

40 2.2 (5.6) 28.2 (71.6) 5.8 (14.8) 43.2
(109.8)

8.7 (22.1) 52.6
(133.6)

59.3 (151.5)

50 3.3 (8.4) 46.6
(118.4)

7.6 (19.3) 61.6
(156.6)

69.4 (176.3)

55 3.4 (8.7) 49.4
(125.5)

4.3 (11.0) 63.7
(161.8)

74.6 (189.5)

Read Ranges
2755-SN3
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500 Scans Per Second at Maximum Scan Angle (Usable 40 Degrees)

Narrow
Element

(Mils)

A Range
Inches
(cm)

B Range
Inches
(cm)

C Range
Inches
(cm)

C+ Range
Inches
(cm)

Maximum Range
Inches
(cm)

5 2.8 (7.1) 3.7 (9.4) 4.7 (12.0)

6 2.4 (6.1) 4.3 (11.0) 7.3 (18.6)

7.5 2.4 (6.1) 4.6 (11.7) 8.9 (22.6)

10 2.7 (6.9) 5.5 (14.0) 7.6 (19.3) 12.9 (32.8) 14.0 (35.6)

13 1.7 (4.3) 6.1 (15.5) 5.4 (13.7) 15.8 (40.2) 15.6 (39.6) 18.0 (45.7) 19.5 (49.6)

15 1.7 (4.3) 6.6 (16.8) 5.0 (12.7) 16.8 (42.7) 13.0 (33.0) 21.8 (55.4) 21.8 (55.4)

20 1.3 (3.3) 7.8 (19.8) 4.0 (10.2) 19.9 (50.6) 10.0 (25.4) 28.3 (71.9) 16.5 (41.9) 27.8 (70.6) 29.7 (75.5)

30 2.2 (5.6) 9.8 (24.9) 2.6 (6.6) 24.4 (62.0) 6.2 (15.8) 37.1 (94.3) 11.0 (28.0) 42.0
(106.7)

42.5 (108.0)

40 3.0 (7.6) 27.4 (69.6) 5.4 (13.7) 43.0
(109.2)

7.7 (19.6) 53.2
(135.2)

56.9 (144.6)

50 4.3 (11.0) 46.0
(116.9)

5.6 (14.0) 62.2
(158.0)

67.9 (172.5)

55 4.9 (12.5) 46.8
(118.9)

4.9 (12.5) 64.3
(163.3)

71.6 (181.9)

Read Ranges
2755-SN5
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800 Scans Per Second at Maximum Scan Angle (Usable 24 Degrees)

Narrow
Element

(Mils)

A Range
Inches
(cm)

B Range
Inches
(cm)

C Range
Inches
(cm)

C+ Range
Inches
(cm)

Maximum Range
Inches
(cm)

5 3.0 (9.1) 3.7 (9.4) 5.7 (14.5)

6 2.8 (7.1) 3.9 (9.9) 8.2 (20.9)

7.5 2.4 (6.1) 4.0 (10.2) 9.7 (24.7) 10.5 (26.7) 10.7 (27.2)

10 2.0 (5.1) 4.9 (12.5) 7.9 (20.1) 12.9 (32.8) 16.0 (40.7)

13 1.8 (4.6) 5.7 (14.5) 6.9 (17.5) 14.7 (37.4) 15.9 (40.4) 19.8 (50.3) 21.0 (53.4)

15 2.1 (5.4) 6.0 (15.3) 6.0 (15.3) 15.3 (38.9) 13.8 (35.1) 23.8 (60.5) 25.4 (64.5)

20 2.6 (6.6) 7.0 (17.8) 5.6 (14.3) 17.9 (45.5) 10.9 (27.7) 29.8 (75.7) 16.6 (42.2) 31.6 (80.3) 34.3 (87.2)

30 5.2 (13.2) 8.8 (22.4) 6.3 (16.0) 21.3 (55.4) 7.8 (19.8) 38.8 (98.6) 11.3 (28.7) 44.3
(112.6)

50.2 (127.5)

40 7.5 (19.1) 24.5 (62.3) 8.2 (20.9) 44.6
(113.3)

8.6 (21.9) 55.6
(141.3)

62.1 (157.8)

50 10.6 (27.0) 48.0
(121.9)

10.1 (25.7) 56.9
(144.6)

69.0 (175.3)

55 11.0 (28.0) 50.1
(127.3)

11.3 (28.7) 61.8
(157.0)

72.5 (184.2)

Read Ranges
2755-SN8
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This appendix describes metacharacters and how they may be used
in a match table rule, message find string, or replacement message.

The Reader uses special characters to perform logical functions on
characters, expressions, or even entire strings.  These characters are
known as metacharacters.  Metacharacters are string manipulation
commands consisting of standard ASCII characters embedded within
search or replacement strings.  Each metacharacter conveys a
specific instruction to the Reader, and acts upon a clearly defined
range within the string.

There are two distinct sets of metacharacters.  One set applies only to
search strings and the other to replacement strings.  If the Reader
encounters a search string metacharacter in a replacement string, it
will interpret it as a standard ASCII character.  Conversely, if the
decoder detects a replacement string metacharacter in a search string,
it will interpret it as a standard ASCII character.  For example, a “*”
in a replacement string is treated as normal text but functions as a
metacharacter in a search string.

Objectives

Description



Metacharacters C–2

Use these metacharacters in the message find string or match table
rule.  They cannot be used in the message pass and fail replacement
strings.

Position Dependent

Character Description and Use

^

$

Note:  The following two metacharacters are position-dependent.  They
must appear in the location specified to be matched.

If the circumflex ( ^ )  is used as the first character in the find string, it
indicates that the characters, other metacharacters, expressions, or
strings must occur at the beginning of the string to be matched.  Note
that the circumflex has a special meaning if used within square brackets,
as explained elsewhere in this chapter.

When the dollar sign is used as the last character in the find string, it
indicates that the characters, other metacharacters, expressions or
strings must occur at the end of the string to be matched.

Wildcard

Character Description and Use

. The period represents any single character, and is used as a
single-character “wildcard”.

String Manipulation

Character Description and Use

?

+

*

Note:  These metacharacters refer to the character, metacharacter,
string, or expression that immediately precedes them.

The question mark instructs the rule to match either no occurrence or
one occurrence of what precedes it.  Use this metacharacter in a string
where the character may not appear at all, or may appear once.

The plus sign instructs the rule to match one or more occurrences of
what precedes it.  Use this metacharacter  in a string where the character
will be present, but you are unsure how many times it appears.

The asterisk instructs the rule to match none or more occurrences of
what precedes it.  Use this metacharacter in a search string where the
character may not appear, or may appear one or more times.

Search Pattern
Metacharacters



Metacharacters  C–3

Logical Operators and Other Special Functions

Character Description and Use

[   ] Square brackets ( [ ] ) instructs the rule to match an incoming string if any
character enclosed within the brackets appears in the string.  A range of
values can be represented within the brackets by separating the first and
last characters in the range by a hyphen.  Square brackets must be used
in pairs.

Note:  The circumflex ( ^ ) can be used as the first character within the
square brackets to reverse the sense of the expression.

Examples

[ABC] Matches “A”, “B”, or “C”

[L–P] Matches “L”, “M”, “N”, “O”, or “P”

[0 – 9] Matches “0”, “1”, “2”, “3”, “4”, “5”, “6”, “7”, “8”, or “9”

[^A – Z] Matches any character that is not upper case 
alphabetic

(   ) Parentheses can be used in two different ways.  They can be used in
search patterns to group characters and metacharacters to form
expressions.  Parentheses must be used in pairs.

Examples

(AB)+ The plus sign applies to the expression (AB).  
Strings that would match this expression include:  
“AB”, “ABAB”, “123AB”, and “AB123”.

Parentheses can also be used to identify strings for use in the Pass/Fail
Replacement String fields.  If a character, string, or expression is
surrounded by parentheses in a search pattern, then it can be later
recalled in a replace pattern with the “\n” metacharacter described
elsewhere in this chapter.

Note:  Parentheses may be nested to form complex expressions.

| A vertical bar (the shifted “\” character on the keyboard) instructs the rule
to match an incoming string if the character or expression on the left or
right of the vertical bar appears in the string.

Examples

A | B Matches “A” or “B”

abc|123 Matches “abc” or “123”

\ The backslash indicates that the following character, which would
normally be interpreted as a metacharacter, should instead be
interpreted as a literal ASCII character.

Example

\. The period ( . ) will be interpreted as a period 
rather than a single character wildcard.



Metacharacters C–4

Use these metacharcters in the message Pass/Fail replacement
strings.   They cannot be used in the message find string or match
table rule.

Replacement  String Metacharacters

Character Description and Use

\n The backslash plus a number 1 through 9 recalls a previously saved
string.  Any character, string or expression that is surrounded by
parentheses in the Find String (as described in previous section) can be
recalled by the replace pattern using the “\n” format.  Since the
parentheses may be nested, the number “n” represents the order of the
groupings as defined by the order of the left parenthesis in the search
pattern.

Examples

Find String = 123(ABC)
Pass/Fail Replacement String = \1
Incoming String = 123ABC456
Host Message = ABC

The Find String above matches the incoming string.  The Pass/Fail
Replacement String states that the string identified within the first
parentheses should be sent to the host.

Find String = (123(ABC))
Pass/Fail Replacement String = \1\2
Incoming String = 123ABC456
Host Message = 123ABCABC

The Find String above matches the incoming string.  The Pass/Fail
Replacement String states that the string identified within the first
parentheses (123ABC), plus the string identified by the second
parentheses(ABC) should be sent to the host.

& When the ampersand ( & ) indicates that the part of the string that
matches the Find String should be sent to the host.  If the string contains
more characters than the Find String, then the additional characters are
discarded.

Examples

Find String = 123ABC
Pass/Fail Replacement String = &
Incoming String = 123ABC
Host Message = 123ABC

The Find String above matches the incoming string.  The Pass/Fail
Replacement String states that the string identified in the Find String
should be sent to the host.

Find String = 123ABC
Pass/Fail Replacement String = &
Incoming String = 123ABC456
Host Message = 123ABC

The Find String above matches the incoming string.  The Pass/Fail
Replacement String states that the string identified in the Find String
should be sent to the host.  This does not include the digits 456.

Replacement String
Metacharacters
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The Reader can generate three types of transmission checks:

• Longitudinal Redundancy Check.
A byte developed by an exclusive OR of all bytes in a message.

• Checksum, Most Significant Byte First
Sixteen bit sum of all the bytes in a message with the most significant
byte transmitted first.

• Checksum, Least Significant Byte First
Sixteen bit sum of all the bytes in a message with the least
significant byte transmitted first.

The following example illustrates a transmission check.  The
message contains the following data:

Start Character  = *
Label Delimiter  = $
End of Message = CR LF
Symbol Data = ABC

The message transmits in this sequence:

* $ A B C $ $ CR LF TRANSMISSION CHECK

The table below shows the transmission check for this message.

Transmission  Check ASCII Character Hex Value Binary Value

* 2A 0010 1010

$ 24 0010 0100

A 41 0100 0001

B 42 0100 0010

C 43 0100 0011

$ 24 0010 0100

$ 24 0010 0100

CR OD 0000 1101

LF OA 0000 1010

LRC Check I 49 0100 1001

Checksum MSB SOH
s

01
73

0000 0001
0111 0011

Checksum LSB s
SOH

73
01

0111 0011
0000 0001

The sum of all bytes in the message is 173 Hex.  Checksums are
transmitted in a sixteen bit format. The value 01 Hex is equivalent to
the ASCII control code SOH, 73 Hex is equivalent to the ASCII
character “s”.



A

ACK

An ASCII control character used to acknowledge the reception and
acceptance of a transmission block.

address

1) A character string that uniquely identifies a memory location.  2)
A character string that uniquely identifies the physical location of an
input or output circuit.

AIM

Automatic Identification Manufacturers.

alphanumeric

The character set containing letters, numbers, punctuation marks and
symbols.

ANSI

American National Standard Institute.  An organization that develops
and publishes voluntary industry standards in the United States.

APM Protocol

Acronym for Application Protocol Messages.  A protocol used by
system integrators who want to design custom applications without
using AdaptaScan software.

application

A use to which something is put, or how it is used.

ASCII

American Standards Code for Information Interchange.  It is a 7-bit
code with an optional parity bit used to represent alphanumerics,
punctuation marks, and control-code characters.

autodiscrimination

The ability of a bar code reader to recognize and correctly decode
more than one symbology.

Glossary
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autoload

The process of automatically transferring scanned character strings
and the symbology type into a match entry value.

B

bar

The dark element of a printed bar code.

bar code

An array of parallel rectangular bars and spaces that together
represent data elements or characters in a particular symbology.  The
bars and spaces are arranged in a predetermined pattern following
unambiguous rules defined by the symbology.

bar code density

The number of characters which can be represented in a linear inch.

bar code label

A label that carries one or more bar code symbols and is suitable to
be affixed to an article.

bar code symbol

A group of bars that represent a character or group of characters
whose width and spacing is determined by a set of rules.  In most
cases, human readable characters are printed below the bars.

bar height

The bar dimension perpendicular to the bar width.

bidirectional decoding

A bar code symbology that can be read successfully independent of
scanning direction.

bit

Binary digit.  The smallest unit of information in the binary
numbering system. A bit is represented by the digits 0 and 1.

bridge

An interface between links in a communication network that routes
messages from one link to another when a station on one link
addresses a message to a station on another link.
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byte

A string of 8 bits, operated on as a unit.

C

capture count

The number of consecutive identical valid decodes that result in a
valid read.

character

One symbol of a set of symbols that normally includes both alpha
and numeric codes plus punctuation marks and other symbols that
may be read, stored, or written.

character self-checking

The feature which allows a bar code reader to determine if a scanned
group of elements is a valid symbol character.  If a symbology is
described as character self-checking, a single printed defect (edge
error) in any symbol character does not produce a valid character.

character set

Those characters available for encoding in a particular automatic
identification technology.

check character

A character included within a symbol whose value is used for the
purpose of performing a mathematical check to ensure the symbol
has been decoded.

check digit

See check character.

clear area

See quiet zone.

code set

The specific assignment of data characters to symbol characters.

configuration

The arrangement and interconnection of hardware components
within a system, and the hardware (switch and jumper) and software
selections that determine the operating characteristics of the system.
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configuration file

The set of attributes which belongs to and defines the operation of a
single physical device.

continuous code

A bar code symbology where all spaces within the symbol are parts
of the characters (Interleaved 2 of 5).  There is no interactive gap in a
continuous bar code symbology.

CPI

Characters per inch.  See density.

D

data character

See character.

decode

The process of translating a bar code into data characters using a
specific set of rules for each symbology.

decoder

As part of a bar code reading system, the electronic package which
receives the signals from the scanner, performs the algorithm to
interpret the signals into meaningful data and provides the interface
to other devices.

density

The number of data characters which can be represented in a linear
unit of measure.  Bar code density is often expressed in characters
per inch (CPI).

discrete code

A bar code or symbol where the space between characters,
intercharacter gap, are not part of the code as with Code 39.  See
continuous code.

E

EAN

European Article Number System.  The international standard bar
code for retail food packages.
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element

A single bar or space.

element width

The thickness of an element measured from the edge closest to the
symbol start character to the trailing edge of the same element.

encoded area

The total linear dimension consisting of all the characters of a code
pattern, including start and stop characters and data.

error

A discrepancy between a computed, observed or measured value or
condition and the true, specified or theoretically correct value or
condition.

F

fault

Any malfunction that interferes with normal system operation.

G

guard bars

1) The bars at the ends and center of a UPC and EAN symbol that
ensure a complete scan of the bar code.  2) The optional bars outside
the quiet zone of an Interleaved 2 of 5 symbol that ensure a complete
scan of the bar code.

H

hexadecimal

A base-16 numbering system that uses the symbols
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F.

host

1) A central controlling computer in a network system.  2) Any
device on a network system that provides a controlling function to
another device on the network.  3) Any intelligent device for which
another device is providing a communication interface to a network.
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I

intercharacter gap

The space between two adjacent bar code characters in a discrete
code (spaces between characters in Code 49).

Interleaved 2 of 5

A bar code in which characters are paired together using bars to
represent the first character and spaces to represent the second.

M

margin

A measure of how well the AdaptaScan can distinguish between
different width bar code elements (bars and spaces).  The margin is
the tolerance remaining before the AdaptaScan can no longer
differentiate between narrow and wide elements.

match

A condition in which decoded data matches data in the match entry.

match entry

An output condition in which decoded data matches and the data in a
match entry configuration.

message

1) A meaningful combination of alphanumeric characters that
establishes the content and format of a report.  2) In a
communication network, the unit of exchange at the application
layer.

message buffer

Storage register for the temporary storage of data that allows
decoding to continue while the host is retrieving data from the serial
port.

message buffer warning

An output condition that occurs when the message buffer has used a
defined amount of the message buffer.

metacharacters

A set of special purpose characters that perform logical functions.
Metacharacters may be entered in the match table rule or message
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find and replacement strings.  There are both metacharacter search
and replacement characters.

misread

A condition which occurs when the data output of a reader does not
agree with the encoded data presented.

modulo check digit or character

A calculated character within a data field used for error detection.
The calculated character is determined by a modulus calculation on
the sum or the weighted sum of the data field contents.

MTBF

Mean Time Between Failure.

multi-drop link

1) A link that has more than 2 stations. 2) Contrasted with
point-to-point link.

N

NAK

Negative acknowledgement.  An ASCII control character terminated
by a receiver as a negative response to the sender.

network

A series of stations (nodes) connected by some type of
communication medium.  A network may be made up of a single
link or multiple links.

no-match

An output condition in which decoded data does not match an entry
in the match code table.

no-read

An output condition in which bar codes on a package are not read
correctly or are incomplete (fields per package count not satisfied).

node

The connection point at which media access is provided.
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O

orientation

The alignment of bars and spaces to the scanner.  Often referred to as
Picket Fence or Step Ladder.

output counter

A counter that is associated with each output condition.  The counter
increments by one each time the condition occurs.

P

package

The definition of a package is variable since a package is whatever
the selected match table entries define as a package.  When defining
a package, you must select the match table entries that indicate a
package has been read.

parity bit

An additional non-data bit attached to a binary word to provide a
check of the data integrity by making the sum of the number of ones
in a word always even or odd.

peer-to-peer

Communications between AdaptaScan Readers over a DeviceNet
network without a network scanner (such as the 1771-SDN scanner).

performance indicator limit

A set point that will produce a discrete output if the performance
indicator falls below the set point value.

picket fence code

A code pattern in which the direction of travel of the symbol is
perpendicular to the bars and spaces of the code.

port

On a communication link, the logic circuitry or software at a station
that determines its communication parameters for a particular
communication channel.
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Q

quiet zone

Spaces preceding the start character of a symbol and following the
stop character.  Sometimes called the clear area.

R

read

A condition in which an entire package is decoded.

reader

A device comprised of a scanner and a decoder.

RS-232C

An EIA standard that specifies electrical, mechanical, and functional
characteristics for serial binary communication circuits in a
point-to-point link.

RS-422

An EIA standard that specifies electrical characteristics of
balanced-voltage digital interface circuits in a point-to-point link.

RS-485

An EIA standard that specified electrical characteristics of
balanced-voltage digital interface circuits in a multi-point link.

S

scan

The search for a symbol or marks which are to be optically
recognized.

scan area

The area intended to contain a bar code symbol.

scan count

The number of scans decoded within a decoder trigger period (up to
99).
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scanner

An electronic device to acquire and convert reflected light from the
bars and spaces of a symbol into electrical signals for processing by
the decoder.

self-checking

A bar code or symbol using a check algorithm which can be applied
to each character to guard against undetected errors.  Codes without
self-checking may employ a check digit or other redundancy in
addition to the data message.

sensor

A device that detects or measures something and generates a
corresponding electrical signal to an input circuit of a controller.

space

The lighter element of a bar code formed by the background between
bars.

spot

The undesirable presence of an area of low reflectance in a space.

start and stop characters

A bar code character that provides the scanner with information
about how the code is bounded and its orientation.  The start
character is normally at the left end of a horizontal code and adjacent
to the most significant character.  The stop character is normally at
the right end of the horizontal code and adjacent to the least
significant character.

step ladder orientation

A code pattern that moves perpendicular to the scan line.

string

A sequence of ASCII characters.

symbol

A combination of characters, including start and stop characters,
quiet zones, data characters and check characters required by a
particular symbology, which forms a complete, scannable entity.

symbol density

The number of characters per linear inch.
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symbol length

The length of the symbol measured from the beginning of the quiet
area adjacent to the start character to the end of the quiet area
adjacent to the stop character.

symbology

The conventions, or rules, which govern the formation of characters
and strings of characters in a bar code symbol.

symbology identifier

An optional three character code which may prefix transmitted data
from a bar code reader indicating the symbology read and any
options enabled in the reader or special features of a symbology
encountered (presence of FNC 1 in Code 128).

T

tag

A collection of information associated with a single variable or I/O
point.

two-width symbology

A bar code symbology whose bar and spaces are characterized
simply as wide or narrow.  Codabar, Code 39, and Interleaved 2 of 5
are examples of two-width symbologies.

U

UPC

Acronym for Universal Product Code.  The standard bar code type
for retail food packaging in the United States.

V

void

The undesirable presence of an area of high reflectance in a bar.

W

window

A display area that the users interacts with to operate a tool.
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word

A unit of data which contains two bytes (16 bits).

X

X dimension

The nominal dimension of the narrow bars and spaces in a bar code
symbol.
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Ack/Nak, terminal protocol, 8–9
AdaptaScan Software

dialogs, 2–8
help, 2–20
installation, 1–2
preferences, 2–18
project window, 2–4
registering, 1–4
running, 2–2, 4–6
version number, 2–7

Addressing
DeviceNet I/O, 9–14
DeviceNet messages, 10–13

Apply Button, 2–12
ASCII, Extended Set, A–2
ASCII Command

as trigger source, 9–12
decode trigger, 7–4

ASCII Command Set, A–1
ASCII trigger, 9–4

configuring, 9–12
Auto–Load, 11–5

trigger, 11–19
Autofocus, 5–6

B
Bar code labels

defining, 6–4
defining symbols, 6–8
label name, 6–5
negative image, 6–6
quiet zone ratio, 6–6
symbologies, 6–8
symbols, 6–6
symbols per scan, 6–5

Baud Rate, 2–17, 8–6
DeviceNet, 8–3

Boxes
check, 2–9
drop–down, 2–9
list, 2–9
text, 2–8

Buttons
apply, 2–12
command, 2–8
ok, 2–12
radio, 2–9
save, 2–12

Byte swapping, 10–10

C
Cable

configuration, 4–5
download, 12–2

Capture Count, 7–5, 7–6
Check Boxes, 2–9
Check Character

Code 39 and Codabar, 6–11
I 2 of 5, 6–12
Matrix 2 of 5, 6–14

Closing, projects, 2–13
Codabar, 6–11
Code 128, 6–8
Code 39, 6–11
Code 93, 6–8
Command Buttons, 2–8
Communication Port

DeviceNet, 8–2
RS–232, 8–2
RS–422/RS–485, 8–2

Communications
database, 2–6
device icon, 2–6
port, 2–18
preferences, 4–7
retries, 2–18
setting port, 4–7
status, 2–6
timeout, 2–18

Compare, 3–4
status, 2–7

Configuration, creating new, 4–8
Configurations

displaying existing, 2–5
importing and exporting, 2–15

Connection icon, 2–6
Connections

configuration cable, 4–5
per reader, 2–7
power, 4–3
status icon, 2–6

Copy, Cut, Paste, 2–14
Counter

displaying contents, 3–7

IndexIndex
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match entry, 11–12
package, 11–18

Cut, Copy, Paste, 2–14

D
Data Bits, 8–6
Database File, 2–3
Debounce Filter, 9–6
Decoder setup

capture count, 7–6
configuring performance indicator, 7–8
count, 7–8
inter–symbol no–read timer, 7–9
margin, 7–8
selecting bar code label, 7–6
selecting trigger source, 7–6

Decoder triggers
ASCII command, 7–4
discrete input, 7–4
input timer, 7–5
package detect, 7–3
self–triggered, 7–3, 7–6
timer, 7–4

Deleting, projects, 2–13
Description, project, 2–17
DeviceNet, 8–2

address, 8–4
baud rate, 8–3
configuring inputs, 9–15
configuring outputs, 9–16
enable pass–through to, 8–7, 10–15
handshaking, 10–13
I/O addressing, 9–14
input, 9–3
master–slave, 9–13, 10–12
message addressing, 10–13
message control example, 10–14
message formatting, 10–12
output, 9–2
peer–to–peer, 9–13
verifying address, 1–6

DF1 communications
retries, 8–10
timeout, 8–10
verification, 8–10

DF1 Protocol, 8–2

DH–485 communications
destination address, 8–12
enabling PCCC, 8–11
master/slave device, 8–11
maximum node, 8–11
node address, 8–11

DH–485 Protocol, 8–2
Dialog boxes, moving, 2–8
Discrete 2 of 5, 6–11

guard bars, 6–11
Discrete inputs

ASCII command, 9–4
configuring, 9–5
decode trigger, 7–4
discrete input, 9–3
package detect, 9–4
timer, 9–4
timer input, 9–4

Discrete outputs, 9–2
configuring, 9–5, 9–8

Downloading
a Reader configuration, 12–3
configuration cable, 12–2
connections, 12–2
firmware, 1–5
using DDE, 14–6

Drop–down Boxes, 2–9
Dynamic Data Exchange (DDE), 14–1

DDE format, 14–2
DDE topics, 14–2
example, 14–7
reading label data, 14–5
reading LED status, 14–4
reading match or package count, 14–5
reading performance, 14–3
writing data, 14–6

E
EAN–13, 6–13
EAN–8, 6–13
Elevation, 5–3
Enable pass through to DeviceNet, 8–7, 10–15
Equipment, required for initial setup, 4–2
Exporting configurations, 2–15
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F
File Transfer, configuration cable, 4–5
Filter, debounce, 9–6
Find String, 10–6
Firmware, downloading, 1–5
Flow Control

DeviceNet messages, 10–13
terminal protocol, 8–8

Flyback, 5–3
Focus, Presets, 5–7
Focusing

autofocus, 5–6
manual focus, 5–6
preset, 5–7
preset focus, 5–6

G
Go On–Line, 3–2
Guard Bar, 7–2

H
Handshaking, DeviceNet messages, 10–13
Hardware Information, displaying, 3–9
Header, terminal protocol, 8–8
Help, 2–20
Hex Conversion, terminal protocol, 8–9

I
I/O LEDs, 3–6
Icons

connection, 2–6
database, 2–6
device, 2–6
toolbar, 2–10

ID, network, 2–5
Importing configurations, 2–15
Input timer, 9–4

configuring, 9–10
decode trigger, 7–5

Inputs
configuring DeviceNet, 9–15
DeviceNet, 9–3
discrete, 9–3

Installation
installation files, 1–4
installing AdaptaScan, 1–2
Reader, 4–5
system requirements, 1–1

Inter–Symbol No–Read Count, 7–9
Interleaved 2 of 5

check character, 6–12, 6–13
guard bars, 6–12, 6–13

Internal Timer, decode trigger, 7–4

L
Label

bar code, 7–6
displaying contents, 3–9
example, 6–2
label setups, 4–11
name, 6–5
setup, 6–2
setup example, 6–3

Laser caution, 5–1
Laser Light Control, 5–4
Laser On LED, 3–6
LED Indicators

I/O, 3–6
Laser On, 3–6
Network, 3–6
On Symbol, 3–6
Power Fault, 3–6
power–up sequence, 4–5
reverse polarity, 4–3
status display, 3–6
Trigger Read, 3–6

Linear scanning, 5–2, 5–5
List Boxes, 2–9

M
Margin, 3–8, 7–8, 10–2
Master / Slave

DH–485 Communications, 8–11
I/O, 9–13

Match Entry Counter, 11–12
Match Exactly, 11–10
Match table

configuring, 11–7
configuring auto–load trigger, 11–19
configuring match entry counter, 11–12
configuring outputs, 11–11
defining contents, 11–9
example, 11–2
match rules, 11–3

Matrix 2 of 5, 6–14
Maximum Node, DH–485 Communications, 8–11
Message Buffer, 8–7
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Messages
alignment, 10–9
configuring contents, 10–6
configuring format, 10–10
counter data, 10–11
data length, 8–6
defining, 10–4
destination, 10–11
DeviceNet, 10–12
field delimiter, 10–11
find string, 10–6
format, 10–2
header, 10–10
replacement string, 10–9
samples, 10–3
source ID, 10–10
swap and pad, 10–10
trailer, 10–10
triggering, 10–5

Metacharacters, C–1
replacement strings, C–4
search patterns, C–2

Monitoring Reader
counters, 3–7
decoded bar code labels, 3–9
LEDs, 3–5
scanner performance, 3–7

N
Name

device, 2–5
on information line, 2–7
reader, 2–5
symbol, 6–8

Negative Image, 6–6
Network ID, 2–5
Network LED, 3–6
Node, DH–485 Communications, 8–11
Non–Printable Characters, A–3

O
OK Button, 2–12
On Symbol Indicator, 3–6
On–Line, how to, 3–2
Opening, projects, 2–3
Output

DeviceNet, 9–2
discrete, 9–2

Outputs
configuring DeviceNet, 9–16
match table, 11–11

P
Package, 11–4

configuring, 11–13
configuring outputs, 11–17
configuring package counter, 11–18
defining, 11–13
match options
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trigger, 11–14
Package detect, 9–4

configuring, 9–6
decode trigger, 7–3

Parity, 8–6
Paste, Cut, Copy, 2–14
Performance indicator, 7–8

count, 7–8
margin, 7–8

Pharma Code, 6–15
bar tolerance, 6–16
decode direction, 6–15
min # of bars, 6–15
min wide to narrow bar ratio, 6–16
space tolerance, 6–16

Ports, communication, 8–2
Power, connection, 4–3
Power Fault LED, 3–6
Power Supply, Connections, 4–3
Preferences

communication, 4–7
network query, 2–19
software, 2–18

Print
contents, 13–6
project report, 13–2
setup, 13–4

Project Name, 2–17
Project Window, 2–4
Projects

applying online changes, 2–12
closing, 2–13
creating new, 4–8
deleting, 2–13
description, 2–3
entering a baud rate, 2–17
entering a description, 2–17
entering a project name, 2–17
opening, 2–3
printing, 13–1
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saving information, 2–12
Protocols

DF1, 8–2, 8–5
DH–485, 8–2, 8–5
Terminal, 8–2, 8–5

Q
Query, 2–19, 3–3
Quiet Zone Ratio, 6–6

R
Radio Button, 2–9
Raster scanning, 5–2, 5–5
Read ranges, B–1
Reader, installation, 4–5
Refresh, 3–3
Registering, software, 1–4
Replacement String, 10–9
Report, contents, 13–6
Reports

creating, 13–2
sending to a file, 13–4

Requirements, system, 1–1
Retries, DF1 communications, 8–10
Reverse Polarity LED, 4–3
RS–232 Port, 8–2
RS–422 Port, 8–2
RS–485 Port, 8–2

S
Save

buttons, 2–12
project info, 2–12

Scan adjustments
elevation, 5–3
flyback, 5–3
scan width, 5–3
upper and lower angles, 5–3

Scan patterns
picket fence orientation, 5–2
step ladder orientation, 5–2

Scan Width, 5–3
Scanner Performance, displaying, 3–7
Scanner Protocol, 8–6
Scanner setup

laser light, 5–4
linear scan parameters, 5–5
raster scan parameters, 5–5

Self trigerred decoding, 7–3, 7–6
Sequence, power–up, 4–5
Serial Port

data bits, 8–6
enable pass–through to DeviceNet, 8–7
enable pass–throuh to DeviceNet, 10–15
parity, 8–6
selecting, 8–7
setup, 8–5
stop bits, 8–6

Serial port setup
configuring the message buffer, 8–7
pass–through to DeviceNet, 8–7, 10–15
selecting a baud rate, 8–6
selecting a protocol, 8–5
selecting port type, 8–7
terminal communications, 8–8

Spin Control, 2–9
Starting AdaptaScan, 2–2
Status

communications, 2–6
information lines, 2–7

Stop Bits, 8–6
Supplements, symbology, 7–2
Supply, power connections, 4–3
Support, Technical, P–3
Swap and pad, 10–10
Symbol Source, messages, 10–7
Symbologies, 6–8, 6–10, 7–2

Codabar, 6–11
Code 128, 6–8
Code 39, 6–11
Code 93, 6–8
Discrete 2 of 5, 6–11
EAN–13, 6–13
EAN–8, 6–13
Interleaved 2 of 5, 6–12
Pharma Code, 6–15
UPC–A, 6–13
UPC–E, 6–13
USPS 2 of 5 Code, 6–17

Symbols
defining, 6–6
defining symbols for a label, 6–8
identifier, 6–8
lengths, 6–9
symbol length, 6–9
symbol name, 6–8
symbology, 6–8

Symbols per Scan, 6–5
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T
Technical Support, P–3
Terminal communications

Hex conversion, 8–9
transmission check, 8–9

Terminal Protocol, 8–2
ACK/NAK, 8–9
flow control, 8–8
header, 8–8
trailer, 8–8

Text Boxes, 2–8
Timeout, DF1 communications, 8–10
Timer, 9–4

configuring, 9–9
Toolbar, 2–10
Trailer, terminal protocol, 8–8
Transmission Check

checksum – LSB, D–1
checksum – MSB, D–1

Trigger
Input Timer, 9–10

Timer, 9–9
Trigger Read LED, 3–6

U
UPC–A, 6–13
UPC–E, 6–13
Uploading configurations, 12–1
USPS 2 of 5 Code, 6–17

decode direction, 6–17
space tolerance, 6–17

V
Verification, DF1 communications, 8–10
Verifying Labels, 11–3

W
WinDnet, 2–18
Windows DeviceNet, 2–18



Publication 2755-838 – June 1998

Rockwell Automation helps its customers receive a superior return on their investment by bringing
together leading brands in industrial automation, creating a broad spectrum of easy-to-integrate
products.  These are supported by local technical resources available worldwide, a global network
of system solutions providers, and the advanced technology resources of Rockwell.

Worldwide representation.

Argentina •  Australia •  Austria •  Bahrain •  Belgium •  Bolivia •  Brazil •  Bulgaria •  Canada •  Chile •  China, People’s Republic of •  Colombia •  Costa Rica •  Croatia •  Cyprus
Czech Republic •  Denmark •  Dominican Republic •  Ecuador •  Egypt •  El Salvador •  Finland •  France •  Germany •  Ghana •  Greece •  Guatemala •  Honduras •  Hong Kong
Hungary •  Iceland •  India •  Indonesia •  Iran •  Ireland • Israel •  Italy •  Jamaica •  Japan •  Jordan •  Korea •  Kuwait •  Lebanon •  Macau •  Malaysia •  Malta •  Mexico • Morocco
The Netherlands • New Zealand •  Nigeria •  Norway •  Oman •  Pakistan •  Panama •  Peru •  Philippines •  Poland •  Portugal •  Puerto Rico •  Qatar •  Romania •  Russia •  Saudi
Arabia •  Singapore •  Slovakia •  Slovenia •  South Africa, Republic of •  Spain •  Sweden • Switzerland •  Taiwan •  Thailand •  Trinidad •  Tunisia •  Turkey •  United Arab Emirates
United Kingdom •  United States •  Uruguay •  Venezuela

Rockwell Automation Headquarters, 1201 South Second Street, Milwaukee, WI 53204-2496 USA, Tel: (1) 414 382-2000 Fax: (1) 414 382-4444
Rockwell Automation European Headquarters, Avenue Hermann Debroux, 46, 1160 Brussels, Belgium, Tel: (32) 2 663 06 00, Fax: (32) 2 663 06 40
Rockwell Automation Asia Pacific Headquarters, 27/F Citicorp Centre, 18 Whitfield Road, Causeway Bay, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846
World Wide Web: http://www.ab.com

Publication 2755-838 – June 1998
Supersedes Publication 2755-838 Dated August 1996

40062-303-01(E)
Copyright 1998 Allen-Bradley Company, Inc.   Printed in USA


	Front Cover
	Important User Information
	Table of Contents
	Preface - Using this Manual
	What is AdaptaScan?
	Intended Audience
	Software Package
	Contents of Manual
	Conventions
	Related Publications
	Technical Support

	1 - Installation
	Chapter Objectives
	System Requirements
	Installing AdaptaScan Software
	Downloading Firmware

	2 - Working with Projects
	Chapter Objectives
	Running AdaptaScan Software
	What is a Database File?
	What is a Project?
	Opening a Project
	Project Window
	AdaptaScan Dialogs
	AdaptaScan Tools
	Saving a Project
	Closing a Project
	Deleting a Project
	Using Cut, Copy and Paste
	Importing/Exporting Reader Configurations
	Entering a Project Name, Description, and Baud Rate
	Preferences
	Help

	3 - On-Line Communications
	Chapter Objectives
	Going On-Line
	Using the Compare Tool
	Monitoring a Reader
	Displaying LED Status
	Displaying Counters
	Displaying Scanner Metrics
	Displaying Bar Code Labels
	Displaying Hardware Information

	4 - Getting Started
	Chapter Objectives
	Configuration Description
	What You Need
	Connecting Power
	Connecting the DL10 Slave
	Installing the Reader
	Connecting the Configuration Cable
	Power-up Sequence
	Running the AdaptaScan Software
	Communications Setup
	Creating a Project
	Creating a New Reader Configuration
	Downloading Firmware
	Defining the Label Setup
	Configuring the Scanner
	Configuring the Decoder
	Configuring the Discrete Outputs
	Defining a Package
	Setting the Timer
	Setting the Serial Port
	Configuring Message Output
	Downloading the Configuration
	Monitoring Reader Operation
	Dataliner Operation

	5 - Scanner Setup
	Chapter Objectives
	Laser Caution
	Scan Patterns
	Scan Adjustments
	Setting up the Scanner
	Focus Options
	Setting the Focus

	6 - Defining Labels
	Chapter Objectives
	Helpful Hints
	What is a Label?
	What is a Label Setup?
	Managing Bar Code Labels
	Defining a Bar Code Label
	Viewing Readers with the Same Bar Code Label Setup
	Defining Symbols for a Bar Code Label
	Selecting Symbologies for a Bar Code Label

	7 - Decoder Setup
	Chapter Objectives
	Helpful Hints
	Decoding Functions
	Valid Symbologies
	When Decoding Occurs
	Capture Count
	Setting Decode Parameters
	Configuring the Performance Indicator
	Viewing Readers with the Same Trigger Source

	8 - Communication Port Settings
	Chapter Objectives
	Communication Ports
	Protocols
	Configuring DeviceNet Parameters
	Configuring the Serial Port
	Configuring Terminal Communications
	Configuring DF1 Communications
	Configuring DH485 Communications
	Viewing Readers with the Same Serial Port Configuration

	9 - Configuring Discrete Inputs and Outputs
	Chapter Objectives
	Helpful Hints
	Type of Outputs
	Types of Inputs
	Selecting Inputs and Outputs
	Configuring Discrete Inputs and the Package Detect
	Configuring Discrete Outputs
	Configuring the Timer
	Configuring the Input Timers 1 and 2
	Configuring an ASCII Trigger
	DeviceNet I/O
	Configuring DeviceNet Inputs
	Configuring DeviceNet Outputs

	10 - Defining Messages
	Chapter Objectives
	What is a Message?
	Message Samples
	Defining Messages
	Configuring the Bar Code Contents of a Message
	Configuring Optional Message Parameters
	Configuring the Message Format
	DeviceNet Messages
	Using Pass-Through to DeviceNet

	11 - Using Match Tables
	Chapter Objectives
	Helpful Hints
	What is a Match Table?
	Match Table Applications
	Match Rules
	Defining a Package
	Using Auto-Load
	Configuring Match Tables
	Configuring the Contents of Match Tables
	Configuring Match Table Outputs
	Configuring the Match Entry Counter
	Configuring a Package Definition
	Configuring a Package Using Match Table Entries
	Configuring Package Outputs
	Configuring the Package Counter
	Configuring the Auto-Load Trigger
	Viewing Readers with Same Trigger Source

	12 - Uploading/Downloading Configurations
	Overview
	Helpful Hints
	Upload/Download Connections
	Configuration Cable (for direct transfers)
	Downloading a Configuration
	Uploading a Configuration

	13 - Printing a Project
	Chapter Objectives
	Setting up a Printer
	Printing a Project
	Sending Project to a File
	Printout Contents

	14 - Dynamic Data Exchange
	Chapter Objectives
	Overview
	DDE Syntax
	AdaptaScan DDE Topics
	Read Performance in Excel
	Read LED Status in Excel
	Read Label Data in Excel
	Read Match or Package Count in Excel
	Writing Commands to a Reader
	Excel Example
	DDE Through the AdaptaScan RS-232 Port

	A - ASCII Character Set
	Extended ASCII Character Set
	Entering Non-Printable ASCII Characters

	B - Preset Read Ranges A, B, C, C+
	Overview
	Read Ranges
	Read Range Data References
	Read Ranges 2755-SN3
	Read Ranges 2755-SN5
	Read Ranges 2755-SN8

	C - Metacharacters
	Objectives
	Description
	Search Pattern Metacharacters
	Replacement String Metacharacters

	D - Transmission Check
	Glossary
	Index
	Back Cover

